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UNIT STANDARD 113843 

 

Unit Standard Title  

Obtain and communicate road transport operational information  

 

NQF Level 

3 

 

Credits 

10 

 

Purpose  

Learners acquiring this standard will be learning towards obtaining a national qualification or are 
working within a transport operations environment, where acquisition of competence against this 
standard will add value to learner’s job, or chances of finding employment 

 

Learning assumed to be in place 

Learners accessing this unit standard / qualification will have demonstrated competence against 
numeracy and literacy at ABET Level 4 or workplace experience. 

 

Unit standard range 

 Whenever incidents occur in all environments under all conditions of operational pressure  
 Well defined, familiar situations within given frameworks of action and/or under 

supervision though there is some evidence of independence 
 Work is conducted within given frameworks  
 National, regional and local language preference considered  
 Interaction from chairperson to member  
 Communication on any related field/topic/issue  
 Communicating with sensitivity and awareness of cultural factors  
 Varying conditions of work and organisational pressure  
 Use computer in basic skills of read and report  
 Language preferred in business  
 Statistics and graphs  
 Knowledge of processes and procedures of access, basic skills to execution  
 Computer generated spreadsheets, statistics and graphs  
 Work on any given desk top computer  
 Ability to use most basic software packages, internet and e-mail  
 Low standards to high standards knowledge  
 Accessing various modes of data  
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 Time and task  
 Different levels of operation  
 Handling information from various sources  
 Working under varying operational conditions  
 Working with management and subordinates  
 Ability to present findings and recommendations to all levels of organisation  
 Use of various media to present findings and recommendations  
 Present information to a wide audience of diverse backgrounds 

 

Specific Outcomes and Assessment Criteria  

Specific Outcome 1: Conduct team discussion meetings. 

Assessment Criteria 

 Meetings are planned and conducted 

 Communication is undertaken orally, by listening, interpreting and asking questions 

 Description of other difficulties that other groupings may encounter are identified and 
acted upon 

 Knowledge of mediation is displayed 

 Interpersonal skills are explained and applied 

 

Specific Outcome 2: Read and report on transport operational information 

Assessment Criteria 

 Basic computer skills are applied 

 Written communication is prepared 

 Language usage is explained 

 Reports are written in an accessible language 

 Analytical skills are developed 

 

Specific Outcome 3: Apply basic end user computing: 

Assessment Criteria 

 Relevant transport information is accessed via computer 

 Data is processed using word processor and spread sheet 

 Electronic mail is used 

 

Specific Outcome 4: Gather and understand operations information 

Assessment Criteria 

 Standard operating procedure involved is explained 

 Technical skills are displayed 
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 Variances are explained and questioned on the spot 

 

Specific Outcome 5: Interpret basic operations information (variance).  

Assessment Criteria 

 Oneself is organised in the workplace (time and task allocation 
 Work flow and processes are explained and applied 
 The meaning of variances is explained 

 

Specific Outcome 6: Make findings and recommendations 

Assessment Criteria 

 Findings are explained and used appropriately 
 Conclusions are drawn thereon 
 Findings and recommendations are communicated to both subordinates and management 
 Findings and recommendations are used to devise and recommend new operational 

processes 

 

Unit Standard Essential Embedded Knowledge 

 Teamwork, negotiation and networking  
 Performance appraisal  
 Knowledge of old and new technologies  
 Responding to crises  
 Computer literacy  
 Sharing quality improvements with other departments  

 

Critical Cross-field Outcomes (CCFO)  

 Work effectively with others as a member of a team and organisation to conduct, statistical 
evaluations 

 Collect, analyse, organise and critically evaluate statistics of operations information for 
transport information evaluation 

 Communicate effectively using language skills in the modes of oral and/or written 
persuasion, in order to communicate statistical information 

 Use science and technology effectively and critically, showing responsibility for effective 
management 
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SECTION 1: TEAM MEETINGS 

 

Specific Outcome 1 

Conduct team discussion meetings. 

 

Assessment Criteria 

 Meetings are planned and conducted 

 Communication is undertaken orally, by listening, interpreting and asking questions 

 Description of other difficulties that other groupings may encounter are identified and 
acted upon 

 Knowledge of mediation is displayed 

 Interpersonal skills are explained and applied 

 

1.1 Communication skills 

a. The Communication Process 

 

 Why do we communicate? 

There is no such thing as “not communicating”.  Even when we sit quietly and do and say nothing, 
we are communicating that we do not or are not communicating.  Yet, so many people take 
communication for granted. 

Many people in the work place for instance believe that if they are talking to others at work, 
writing memos or attending meetings then they are in fact communicating effectively!  
Unfortunately, that is not true.  It requires a lot more than just that! 

Communicating is not simply a matter of speaking or writing words and hoping for the best.   

If we consider that up to 80% of an employee’s time is spent communicating, the 
question we have to ask ourselves is “How well are we communicating?” 

 

 The process of communication 

As human beings we communicate with each other every day and when we communicate it is with 
a specific purpose in mind.  

 To interact  
 To inform  
 To find out 
 To influence 
 To regulate 
 To entertain 
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 To record   

You communicate by means of a language that is understood by the person or persons you are 
communicating with: 

 You are communicating when you are speaking face-to-face, or speaking over the telephone 
or cell phone, or even the Internet. 

 You communicate when you read an article written by an author in a newspaper, in a 
magazine, in a letter; in a report; and in a book. 

 When you write you are communicating through written words rather than spoken words.  
You write the words in stead of speaking the words. 

Communicate - .according to the Oxford English Dictionary, it means the “share or 
exchange of information”. 

Since the beginning of time man has communicated with his fellow beings.  This “sharing or 
exchange of information” may take on many forms and many instruments may be utilised to 
convey this information.  The reaction to the transfer of information may also vary, depending on a 
number of factors. 

Communication is a two way street – information is shared with another party and the 
other party normally reacts in some way, even if they do absolutely nothing. 

 

 Example 

A bus driver communicates with other people all the time.  It starts when he receives his 
instructions about his schedule and route.  He receives information and reacts to this exchange of 
information by getting into his bus and driving according to schedule.  Upon his return to the depot 
he communicates information about the route and schedule e.g. road conditions, number of 
passengers, etc., as well as the condition of his vehicle back to the appropriate authorities. 

Along his route he communicates with passengers when they board the bus.  He communicates 
with the controller and fellow drivers.  In the event of a breakdown he will communicate with the 
workshop personnel to inform them about the problem. 

The most important communication the driver engages in is with other road users. By using 
warning devices like brake lights, indicators, hazard lights, hand signals (not the one- or two finger 
kind), he communicates his intentions to his fellow road users. 

In the event of the driver NOT communicating his intentions he might cause an accident and have 
to communicate with the police and ultimately a magistrate.  Avoid communication with these two 
at all cost!! 

 

 

TUBBS & MOSS, 1994 

Definition of communication “Human communication is the process whereby 
meaning is created between two or more people.” 

 

Communication is the interaction between at least two people, the 
communicator and the recipient. 
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 The Communication Process 

 

 

There can, however, be more than one recipient, like an audience listening to a speech or 
watching a movie. 

 

 The Communicator  

The communicator starts the communication process by conveying a 
message about what he feels, thinks or believes about a matter that he 
wishes to share with others. 

 

 The message 

The message is that which the communicator wishes to convey to others by way of 
communication and can be used by the communicator to attempt to persuade 
someone to his way of thinking or it can be an idea, thought or feeling that the 
communicator wishes to share with others.  This message needs to be 
communicated in some form, for while the message remains a thought in the 
communicator’s mind, it cannot be received or interpreted by a recipient. 

Message 

Recipient Communicator 

Feedback 
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 The Recipient  

The recipient receives the message, interprets it and reacts.  This reaction is called 
feedback.   

 

 Feedback 

Feedback is not always verbal, but can also be conveyed by means of other reactions 
e.g. applause after a good performance 

 

b. What you do when you communicate: 

 You listen to what someone is saying – you think about what has been said  - you respond;   
 You think about what you want to say- you speak your thoughts, opinions, etc.  you wait 

for a response  
 You read the words written by an author- you think about what you have read - you 

respond   
 You think about what you want to say– you write the words you want to speak – you wait 

for a response.  

Response refers to the feedback you give or get when communicating.  It can either be oral or 
spoken, or it can be written.  It can be in the form of a suggestion, advice, recommendation, 
statement, instruction, command, etc or it can be in the form of an assessment; a test, task, 
examination, demonstration, observation, etc.   

 Remember: It is not always what you say that is important.  It is how you say it. You are 
continuously being assessed either directly or indirectly in all you say, or do, or write.  Your 
knowledge, competency or your capabilities are measured when you respond or give 
feedback 

 Each type of feedback has different criteria or outcomes against which it is measured or 
assessed.   These outcomes are in fact the skills you are required to demonstrate to prove 
that you are competent in what you are doing, saying, reading or writing.  

 Meaningful feedback requires purposeful preparation and presentation.   
 

 

 

 

 

 

You first have to interpret what you have heard, or read before you can respond or give 
meaningful feedback.  Your, response or reaction demonstrates your interpretation, and your 
understanding of what you have heard, seen, felt, tasted, smelled, experienced or read.   

When you interpret a message, whether it is a picture you look at; words someone is speaking; or 
the written word you are reading; your mind instinctively works through the following steps: 

 First you extract or unpack key words and key concepts so that you can speak about what 
is relevant. They can be extracted from your general knowledge bank or your experience, 
or from what you have heard and read about.   

When participating in a conversation you are constantly interpreting the words you hear 
so that you can unpack or extract important information.  This you do in order give an 
appropriate response.  It is a process that you work through instinctively before you 

respond or give feedback or say something. 
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Example: You are required to give feedback on the effect crime has on a community and how it can be 
minimised  

A Brainstorm to unpack or collect information 

 

    Dissatisfaction Community  poverty 

    gangs 

  unemployment          fear 

 

  boredom           anger 

          

 power          recreation 

   aggression 

              security  

          emotions 

       job creation 

    violence    control 

 

 Secondly you repack or rearrange and restructure these key ideas (keywords and key 
concepts) into sentences. Sentences are developed into paragraphs and organised into a 
logical sequence so that the information you share is meaningful.   

 

Crime 

In order to repack or make an interpretation of these key ideas you have to make use of 
questions (what, when where, why who and how) to rearrange or restructure the 

brainstorm into a mind map or a flow diagram.  This you do by means of grouping key 
concepts or related key ideas to show how they link or flow into each other in a logical 

sequence, to make sense. 

 

Unpacking or extracting key ideas is like a brainstorm.  Ideas are randomly thought of 
and not placed in a specific order.  This is part of preparing a response starting with 

careful planning what you want to say. 
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Example: A mind map or flow diagram to restructure and organise the key ideas generated on crime in a 
logic way. 

 

  Because of-   dissatisfaction   involves community members 

            unemployment           friends, family 

                boredom             youths 

                   Poverty               children 

 

    emotions -   anger  resulting in   violence 

                 fear     power struggles   
                          aggression         control  

                 gangs 

   

   Prevented through -     -community support.   

                   Recreation opportunities 

                     Job creation 

                       security 

 

 

 

 

 Then only do you respond by giving either verbal or written feedback. This is the final part 
of your preparation where you focus on how you are going to present your response or 
feedback.  It is important to be familiar with the correct format in which you choose to give 
feedback or to respond. 

Crime 

You do not have to make two diagrams.  You can start with a brainstorm and then with 
the help of questions (What; When; Where; Why; Who; and How) you can develop the 

brainstorm into a flow diagram to map out your thoughts or your interpretation. 
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1.2 Types Of Meetings 

Meetings can perform a wide variety of functions: 

a. Informative/Advisory 

 To give and receive information 
 To keep in touch 
 To co-ordinate activities 
 To record progress towards goals 

 

b. Consultative 

 To resolve objections 
 To involve people in changes taking place or a new course of action 
 To get to know people and to build team spirit 

 

c. Problem-solving 

 To create ideas 
 To identify various courses of action 
 To get things moving 

 

d. Decision-taking 

 To generate commitment 
 To take decisions 
 To share responsibility 
 To initiate action 

 

e. Negotiating 

 To create an agreement or contract 
 To find the best solution 
 To achieve compromise 

 

f. Briefing meetings 

 To pass on instructions, in other words to inform 
 

g. Consultation meetings 

 Regular meetings of management representatives and employees are held to discuss 
grievances and problems in regard to working conditions 
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1.3 How To Chair A Meeting 

A chairman is elected, usually at the AGM, to preside at meetings.  If the chairman is unable to 
attend a meeting, the vice-chairman will preside.  If neither the chairman not the vice-chairman is 
available, the meeting may elect a chairman for that meeting.  Sometimes the office of chairman 
rotates among the members of the meeting or committee. 

The chairman has to ensure that meetings are conducted according to the constitutional and legal 
stipulations. 

The chairman has to ensure that all business is conducted fairly and according to the rules.  He will 
have to decide whether  

 a speaker is out of order 
 an item has been fairly introduced under the matters arising or general items on the agenda 

At times the chairman will have to use his initiative to solve problems that are not covered by the 
written rules.  This is why many aspects of procedure in formal meetings exist to reinforce the 
authority of the chairman so that he can control the meeting.  An example is remarks that have to 
be addressed to the chairman and not other members of the committee or meeting. 

To summarise what we have done so far, the documentation required before, during and after a 
meeting are:  

 Notice of meeting 
 Agenda: must be circulated in time for members to add items to the agenda 
 Minutes of previous meeting: must be circulated in time for members to read through them 

in order to prepare for the meeting 
 Attendance register: must be prepared beforehand so that members who attend can sign 

The chairman must ensure that the secretary has extra copies of the agenda and the minutes of 
the previous meeting at hand and also that the attendance register has been prepared.  The 
chairman must also ensure that the physical arrangements have been completed.  It is the 
secretary’s duty to make all the arrangements, but the chairman is ultimately responsible if 
everything is not arranged properly, so he must check up on the secretary to ensure that 
everything is in place. 

 

a. Open The Meeting 

The meeting starts once the chairman has declared it open.  The secretary will note the time the 
meeting was declared open.  The items on the agenda are then discussed in the order they appear, 

 

b. Apologies  

The chairman announces apologies received from members who are unable to attend the meeting. 

 

c. Minutes Of The Last Meeting 

The chairman will ask members if there are any corrections.  This is why the minutes of the 
previous meeting must be circulated to the members before the meeting.  After making 
corrections, if there are any, the minutes are signed as being a true record of events. 
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d. Matters Arising 

Matters arising from the previous meeting are discussed.  There might have been developments, 
new information might have been gathered or members had to do something that relates to the 
previous meeting. 

 

e. Correspondence 

The chairman will inform the members if any correspondence was received since the last meeting. 

 

f. New Business 

These are the items that have to be discussed and decisions must be made on these items by the 
members attending the meeting. 

 

g. General 

This is an opportunity for members to raise additional matters for discussion. 

 

h. Date Of The Next Meeting 

The date and time and sometimes the place of the next meeting are announced by the chairman. 

 

i. Adjournment 

The meeting is declared closed or adjourned. 

 

 

 

 

1.4 Preparing For A Meeting 

Before the meeting ask yourself these questions…. 

 Is the meeting really necessary? 

Yes / no? 

 

 What are the alternatives to a meeting? 

How many of the meetings we have attended could have been replaced by a brief chat, a memo, a 
quick telephone call, a decision by the person in charge? Could the issues have been added to the 
agenda of another meeting? Before arranging any meeting we should look at all the other 
alternatives. 
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 What are the objectives of the meeting? 

We should clearly define the meeting’s objectives, and communicate them to participants when 
arranging the meeting. This gives others the chance to prepare in advance and ensures that people 
do not have to sit through an irrelevant meeting because they thought it was going to be about 
something else.  

 

 What will be the benefits of achieving the objectives? 

Once we have set the objectives for the meeting, we need to ask what the benefit of achieving 
each objective will be. The benefits will enable us to prioritise the agenda and focus on the 
important items.  

 

a. Keep To The Time Allocated 

During the meeting…. 

 Start on time and close the door. As latecomers arrive we should never interrupt the 
meeting to bring them up to date on what has been discussed. 

 Try to identify hidden agendas by asking participants what they personally want to get out 
of the meeting and if there are any specific issues they want to discuss. 

 Decide who will take the minutes and what the format will be. Does it need to be 
recorded (e.g. IR related meeting). Confirm details and deadlines for distribution with the 
minute taker. 

 Interrupt rambling discussions or irrelevant contributions.  Assert yourself and get the 
group to focus on the agenda.  Briefly summarise the point being made, and move on. 
Ensure that all the items on the agenda are covered 

 Encourage participation by reacting positively to contributions. There is no quicker way to 
silence a group than to be over critical. If someone with potentially useful contributions is 
silent, be sensitive about asking directly in the meeting. Get participants to come to 
meetings with suggestions. They will only be able to do this if they have read the agenda 
and any supporting documentation.  

 Avoid external interruptions. During a meeting a US senator was having with the 
President the phone rang continuously and the President was getting involved in a 
protracted conversation each time he answered it.  Eventually, the senator left the room 
and called the oval office extension. He immediately got the President’s attention! 

 Put your phone on voice mail!  ‘Do not disturb’ signs should also be used for office doors 
indicating the time that the meeting will be over. If someone does break through initial 
barriers, arrange a time when you can get back to them. 

 Avoid unproductive arguments by asking people to continue their discussion after the 
meeting. If that is not possible or appropriate, acknowledge the differing points of view and 
ask participants to focus on a solution. It will all depend on the issue. 

 Summarise decisions taken, follow-up action and deadlines after each item on the agenda 
has been discussed.  

 Finish the meeting on time 



18 | P a g e  

 

Here is a checklist that can help you to chair effective meetings: 

Objective 

Chief Danger 
to the 

effectiveness 
of the 

meeting 

Techniques to let the meeting flow 

Mark the 
techniques 
that need 

more 
attention 

Unite the 
group 

Aggression 

Let off the steam – calm down the members’ 
tempers 

 

Don’t take sides  

Bring in the other members of the meeting:  
encourage or request their participation and 
views on the item under discussion 

 

Focus the 
group 

Getting off the 
point 

Stick to the facts:  when members get off the 
point, bring them back to the item under 
discussion 

 

Stay alert and stay in charge of the meeting, 
don’t let the discussions get out of hand 

 

Test comprehension: make sure that members 
understand what is being discussed and what 
they have to decide on 

 

If necessary, rephrase what a speaker has said 
and check to ensure you have the facts right 

 

Mobilise 
the group 

Squashing: 
when 

members want 
to suppress a 

motion 

Protect the weak members of the group from 
aggression and being steam-rolled into a decision 

 

Check round the group whether they are ready to 
make a decision 

 

Record suggestions  

Build up ideas  

 



19 | P a g e  

 

 

1.5 Attending Other People’s Meetings 

 Before the meeting ask yourself these questions…. 

 Do I really need to attend the meeting? 
 Am I sure of the correct time/location of the meeting? Have I received the agenda and 

relevant documentation? 
 Have I arranged my schedule so that I will get to the meeting on time? 
 What do I want to contribute to the meeting?  Have I made notes about my contributions? 
 What do I want to get out of the meeting? 
 What background paperwork do I need to tackle?  Have I collected all the information I 

need to make effective contributions? 
 What recommendations will I make and will these recommendations be objective? 

 

 During the meeting…. 

 Contribute constructively 
 Do not interrupt other speakers, unless they are deviating from the points on the agenda. 
 Restrict your own contributions to the items on the agenda 
 Focus on the objectives of the team and the purpose of the meeting or discussion 
 Be clear about any follow-up steps to take 
 Avoid private discussions  
 Make positive recommendations 

 

1.6 Deal With Differing Views 
 

a. The chairman 

 The Chairman must: - 

 Preside at the meeting and see that order is kept. 
 Be fair and impartial to all sides. 
 Allow each side to present their case.  
 Summarise and seek clarification on points made. 
 See that the agenda is followed. 
 He may adjourn meetings when deadlocks threaten to develop, and allow members to 

caucus. 
 He will call for a vote and in the case of a stalemate he may be allowed a casting vote. If 

there is a stalemate, it means that the committee is divided over an issue. It is therefore 
sometimes wise for the chairman not to give his casting vote.  

 In this instance it means that the motion is lost, or he may choose to give his casting vote in 
such a way as to preserve the “Status Quo”) 

 Comment on a possible illegal or improper statement. 
 Give a ruling on a point of order. 
 He must sign the minutes of the previous meeting. 

 



20 | P a g e  

 

b. Handling Difficult / Problem People 

Some differences in levels of participation are a natural outcome of people’s personalities.  The 
extrovert could dominate any group process and the shy person could withdraw.  We may find that 
out of every 100 people that there’s at least one difficult person.  So how do you handle the 
troublemaker? 

 

 What Not To Do: 

What you should not do are any of those things that are the most natural and instinctive ways to 
react.  You should not: 

 Be defensive and argue with them 
 Preach, lecture or threaten them 
 Ignore them 
 Criticise them 
 Tell them where to go 
 Put them down by using ridicule or shame 

 

 The Too Much And Too Little Participation Individuals 

The domineering or too talkative person interrupts, goes on and on with their own ideas or 
experiences, and generally controls what is happening.   

Other group members may not be able to participate fully.  Time may run out before everything is 
completed for that session.  Overly vocal individuals may simply be very enthusiastic and excited 
about what is happening; what the facilitator needs to do is harness this energy. 

To deal with someone who participates too much you could … 

 Establish a procedure whereby each person contributes one idea to the topic being 
discussed and then waits until every other member does the same before contributing 
again. 

 Establish time limits for the discussion.  Ask the team for permission to use more time for 
this discussion. 

 Establish or remind them of guidelines for discussion and participation. 
 Assertively interrupt the person who is rambling, ask them to summarise their point quickly 

so that the others can add their ideas too.  Relate the ideas to the main discussion. 
 Empathetically support the dominator’s thoughts, then cut him or her off politely.  Say, 

“Thank you for giving us all of those ideas.  Let’s hear from the others in the group.” 

At the other end of the spectrum, the withdrawn or silent individual can also cause a problem, 
because their input is hidden from the group.  It is also difficult to assess what they are getting out 
of the experience.  Silent individuals may just be nervous about expressing themselves in front of 
the group.  The facilitator’s job is to draw them out. 

To deal with someone who participates too little you could … 

 Do some warm-up activities when the team first starts to work together and occasionally 
thereafter.  This should help even the quieter person to feel more comfortable with the 
other team members. 

 Establish and remind the team of guidelines for participating fully. 
 Use a structured process, such as asking each person to contribute something about the 

topic.  But let them pass if they really don’t want to speak. 
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 Re-group all quiet people together or a quiet person with a caring person. 
 Talk with the shy person privately.  Find out what they are thinking and feeling.  Ask them 

how they would like to participate.  Ask questions like: 

 “Are you enjoying the meeting?” 
 “Are you getting anything out of the meeting?” 
 “How can the team meet your needs?” 
 “Is there anything I can do to help you feel more comfortable?” 

 

 The Avoider 

When there are unresolved conflicts, hidden agendas, or tough issues, people who dislike 
conflict will avoid what they perceive as unpleasant.   

However, these conflicts and issues must be addressed if the team is to accomplish its goals.  Some 
avoiders solve the problem by not even attending the meeting, coming late, changing the subject, 
or leaving early. 

To deal with an avoider you could … 

 Not let conflicts remain unresolved.  Keep the group working on problems and tough issues 
until solutions are found. 

 Direct questions to and solicit ideas from the avoider so this person stays involved. 
 Talk with him or her privately to find out what’s happening. 

 

 The Uncooperative Person 

This person blocks the team’s progress by objecting to ideas with comments that are totally 
out of line or unreasonable.  

Usually they stubbornly defend their position.  They may interrupt a lot.  Like the avoiders, they 
may arrive late, leave early, or not come at all. 

To deal with someone who is uncooperative you could … 

 Incorporate something in the original guidelines that deals with cooperation and 
interruptions. 

 Encourage the uncooperative person to explain the reasons behind his/her objection.  Look 
for any aspect of the position that supports the team’s ideas so that this person moves 
closer to the centre. 

 Refocus their participation by making them either a recorder or process observer. 
 Meet the person privately and try to determine what is behind this behaviour.  Explain the 

importance of cooperation in the team. 
 Ask the group to deal with this uncooperative behaviour. 

 

 The Degrader 

Another type of problem person is the degrader, who puts down others’ ideas and suggestions 
in a joking or condescending way.   

This problem must be nipped early on, otherwise members will feel inhibited to participate, out of 
fear of becoming the degrader’s next victim. 
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To deal with a degrader you could … 

 When your team first gets together, establish your contact and guidelines with them.  
These guidelines should include the rule that all ideas will be accepted.  The very first time 
someone puts another person down, this rule must be enforced.  To maintain the problem 
person’s self-esteem, you may need to confront them in private. 

 Confront the degrader with, “You may have a point, but we need to solve our problem.” 
 If two people are degrading, separate them. 
 Meet the degrader privately and try to determine what is behind this negative behaviour.  

Explain the importance of treating others positively. 
 Work with the team sponsor to determine if the degrader should remain on the team. 

 

 The Turf Builder or Protector 

Some individuals are continually looking for ways to build their own personal turf or to 
protect what they have.   

This kind of person is often insecure and afraid to lose any power or control.  They may not trust 
the other members of the team. 

To deal with a turf builder or protector you could … 

 Take sufficient time in the forming stage to hear everyone’s expectations and concerns. 
 Provide the person with the opportunity to explain what they know.  They often like to talk 

about their experiences. 
 Meet the person privately to discuss how they will benefit by remaining open to the 

possibilities of change the team is addressing.  Capitalise on whatever you discover that 
motivates this person. 

 

 The Latecomer 

This type of person comes late to meetings.   

Either you know in advance that they will be late or, worse, they just show up late.  They often 
disrupt the group’s process by asking about something that has already been discussed. 

To deal with a latecomer you could … 

 If you know in advance someone will be coming late, decide which team member will fill 
them in when they arrive.  This is done off to the side so the group goes on with what they 
were doing. 

 If someone arrives late with no advance notice, select a team member who can fill them in 
when they arrive.  This is done off to the side so the group goes on. 

 If the same individual is always late, speak with them privately, explain why it is important 
to be on time and the impact it has on the team when they are late.  Then give positive 
feedback when they do come on time. 

 

 The Side Conversationalists 

When two people lean over and engage in a private conversation, it can be disconcerting to 
the facilitator and interrupts the team’s process.   

Even more disruptive is when two people (or more) start a second conversation across the table. 
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To deal with side conversationalists you could … 

 Set guidelines and expectations at the beginning of the meeting. 
 Stand near the talkers.  Walk behind them and put your hands on their shoulders. 
 Stop and ask them a question. 
 Stop the meeting and ask those involved in the side conversation to share with the group 

what they are talking about.  They may only be clarifying what is being discussed or one 
person may be filling the other in on important background information. 

 Stop the meeting and comment that it is difficult for you to hear the discussion or to 
concentrate on the topic at hand with side conversations occurring. 

 

 The Whiner or Agitator 

There are some people who like to complain or whine about problems, past history, or the 
merit of new ideas.   

This behaviour sometimes spills over into agitating others by talking with them on the side to get 
their support against new ideas. 

To deal with a whiner or agitator you could … 

 Use the general guideline that for every negative opinion, that person must suggest one 
solution. 

 Confront the person’s behaviour.  Interrupt the whining and ask them to summarise their 
point in one sentence. 

 Give them a job to do, like recording. 
 Give positive feedback when they show a positive behaviour. 
 If two people are whining, separate them. 

 

 The Diverter 

Some people just can’t stay on the topic.   

They love to ask unrelated questions, tell lengthy stories, or dwell on the history of the problem.  
This may happen because they, in fact, do know a lot that they think the others need to hear, or 
they may just like to hear themselves talk. 

To deal with a diverter you could … 

 Establish guidelines for discussion and participation.  If necessary, remind the diverter of 
those guidelines. 

 Establish time limits for the discussion. 
 Change the discussion to a written assignment. 
 Cut him or her off politely. 
 Assertively interrupt the person who is diverting and ask them to summarise their point 

quickly so that the others can add their ideas too.  Relate the ideas to the main discussion. 

c. Techniques to create progress in a meeting 

Differing opinions of people who attend meetings can lead to a lack of progress: the same point is 
discussed over and over again and no decision is made.  Remember that any discussion should 
contribute to the progress of the meeting and the chairman should ensure that people do not 
monopolise the meeting or stray from the point. 
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You can use these techniques to ensure that the meeting progresses as planned: 

 Gatekeeping  

Be a gatekeeper/expediter: keep communication channels open by encouraging or facilitating the 
participation of others (We haven’t heard the ideas of Mr X yet), and so on); propose regulating 
the flow of information, for example limits on length of contributions so all can have a say. 

If necessary, be firm and directive; ask them if they wish to continue; continue the meeting only 
after a 'yes' from all parties 

 

 Summarise  

Interrupt rambling discussions or irrelevant contributions.  Assert yourself and get the group to 
focus on the agenda.  Briefly summarise the point being made, and move on. Ensure that all the 
items on the agenda are covered 

Also summarise decisions taken, follow-up action and deadlines after each item on the agenda 
has been discussed 

 

 Repeating 

Repeat the last statement that had bearing on the subject of the meeting, and redirect the 
attention of the attendees to the purpose of the meeting. 

 

 Redirect 

Gently interrupt the speaker and redirect the attention of the attendees to the purpose of the 
meeting. 

 

 Rephrase 

Rephrase means to repeat someone else’s words in your own words.  Rephrase the speaker’s 
statement in your own words, check that the attendees agree and move on with the meeting. 

 

 Avoid external interruptions.  

During a meeting a US senator was having with the President the phone rang continuously and the 
President was getting involved in a protracted conversation each time he answered it.  Eventually, 
the senator left the room and called the oval office extension. He immediately got the President’s 
attention! 

Which method you choose depends on you and the situation.  The important thing is that you 
interrupt the person speaking without being rude and then refocus everyone’s attention on the 
item on the agenda that was under discussion.  
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1.7 Making Decisions During Meetings 

a. Debating Procedure 

Debating must be conducted in an orderly manner.  To achieve this goal the participants and the 
chairperson must adhere to the following: 

 Matters must be discussed in the order in which they appear on the agenda. 
 For the sake of fairness and balance, the chairperson should strive to let speakers 

supporting and opposing the motion speak alternately. 
 Members representing a minority group or opinion should be granted sufficient opportunity 

to state their case. 
 Debate may be interrupted at any time by raising a point of order. 
 A person addressing members should do so through the chairperson 
 The chairperson should see that the meeting is not drawn out and delayed by repetitive 

arguments. 
 Every member has the right to speak once to the motion and once to any amendment. The 

proposer of a motion has the right to reply. The chairperson has the right to reply to the 
total debate by summing up or clarifying. 

 

Whatever the method of decision-making that your team adopts, all the members have to ensure 
that the process of decision-making is followed: 

 Define the problem 
 Examine the facts 
 Select the optimum decision 
 Formulate the decision 
 Communicate the decision 
 Evaluate outcome 

 

1.8 Deal With Conflict 

Any meeting has the potential for conflict.  When a number of 
people have to agree on one item, there is bound to be 
disagreement.  People have opposing points of view and believe 
that they are right and everyone should see the matter as they do. 

Ultimately members of the human race are unable to live with 
each other without conflict. This tendency towards conflict is an 
ever-present danger in business and is yet another challenge for 
the manager.  Individuals experience conflict when their opinions, 
values, needs or actions are in opposition to others. Teams 
experience conflict as they learn to work together. 

The most valuable aspect of conflict is the energy that it generates, and conflict management is 
not an attempt to suppress this energy, but to use it constructively. Conflict caused by differing 
viewpoints may lead to harsh and painful situations or it can be transformed into creative and 
productive dialogue.  

The differences between people stimulate debate, creativity, solutions to problems and change.  
Too little conflict could result in the organisation stagnating.  Too much could result in chaos.  

What is required is a healthy approach to dealing with conflict 
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Conflict will become easier to manage if we see it as inevitable but not necessarily destructive, 
and as a problem to be solved rather than a battle to be won. 

As a member of a workforce it is important to accept conflict, see it as an opportunity and manage 
it in such a way that it enhances the competence and commitment of all parties involved.  All 
parties gain more by co-operation than by conflict. 

Conflict: 

 is inevitable and a reality of life; 
 is not a dirty word, and; 
 takes place for many reasons and has many forms 

 

 Which approach? 

The ability to manage conflict is a critical interpersonal skill that must be highly developed 
for the following reasons: 

 To manage change 
 To understand cultural differences 
 To become effective team members and leaders 

Without the ability to manage conflict, you cannot be successful in your organisation. Your ability 
to effectively manage differences is a critical factor in your personal and professional success. 

Although conflict occurs at all levels of the organisation, we personally face differences at three 
levels: bosses, peers, and employees (if we supervise). The issue here is not the occurrence of 
conflict, but rather how you handle it. 

 

a. Conflict in Teams 

From what we have said about teams and the responsibilities and duties of team members, it is 
obvious that conflict can occur easily in teams and groups, since the expectations of team 
members are high, as are the responsibilities of individual team members.  As soon as one member 
feels that s/he is doing more than the others, conflict can occur. 

 

b. Conflict Management Styles  

There are five basic approaches to managing conflict  

 Integrating 

 Obliging 

 Dominating 

 Avoiding 

 Compromising 

and two dimensions which influence the approach: 

 Concern for self and  

 Concern for others. 
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 Integrating 

Individuals who choose this style seek an exchange of information. There is a desire to examine 
differences and reach a solution that is acceptable to all parties.  

This style is typically associated with problem solving and is effective when issues are complex. 
The integrating style encourages creative thinking.  

Developing alternatives is one strength of this style. The emphasis on both self and others brings 
together information from differing  perspectives. 

(ADAPTED FROM A. RAHIM’S ORGANISATIONAL CONFLICT INVENTORIES.  CONSULTING PSYCHOLOGISTS 

PRESS, 1983) 

 Obliging 

This management style places a high value on others but a low value on self. This style may reflect 
an individual’s self-esteem.  

It is also useful in the deliberate elevation of another person, making them feel better about an 
issue. The obliging strategy plays down the differences among parties while looking for common 
ground.  
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The high concern for others causes an individual to satisfy and meet the needs of others, often 
giving up something of importance to self.  

This can preserve a relationship when used effectively. By using the obliging style, the manager 
passively accepts the power of others, buying time to assess situations and survey alternatives. 

 

 Dominating 

This style is the opposite of obliging. The emphasis is placed on self.  

While the obliging individual may neglect his own needs, the dominating style overlooks the needs 
of others. It is an effective strategy when a quick decision is needed or if a 
matter lacks importance. 

This strategy can be reactionary, activated by self-preservation.  

The dominating style is helpful if there is a lack of knowledge or expertise.  
The ability to provide expert counsel or address issues comes from this 
dominating style. 

 

 Avoiding 

The avoider does not place a value on either self or others.  

The negative aspects of the avoiding style include ‘passing the buck’ or 
sidestepping an issue. A manager using this style will withdraw from the events, 
leaving others to struggle with the results.  

When issues are not important, deferring action allows things to cool off – an 
effective use of avoidance.  

It is also an effective style when time is needed. This style can be frustrating for 
others because answers are slow in developing. 

 

 Compromising 

It is neither high nor low in concern for others or self. This is a middle-of-the-road orientation. 

In compromise, everyone has something to give and something to take.  

The compromise is most effective as a tool when issues are complex or when there is a balance of 
power.  

Compromise can be chosen when other methods have failed and both parties are looking for 
middle ground.  

Compromise may mean splitting the difference or exchanging concessions. It almost always means 
all parties give up something in order to attain resolution. 

 

c. Which approach? 

The ability to manage conflict is a critical interpersonal skill that must be highly developed for the 
following reasons: 
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 To manage change 

 To understand cultural differences 

 To become effective team members and leaders 

 

Without the ability to manage conflict, you cannot be successful in your organization. Your 
ability to effectively manage differences is a critical factor in your personal and professional 
success 

Although conflict occurs at all levels of the organisation, we personally face differences at three 
levels: bosses, peers, and employees (if we supervise). The issue here is not the occurrence of 
conflict, but rather how you handle it. 

Consider these four questions when determining the approach toward the person with whom 
you have a conflict. 

 What is the person’s behavioural style when conflict occurs? 

 What is the person’s usual method of handling conflict? 

 What might he or she value in this situation? 

 What should your approach be? 

 

 Which style is appropriate for a specific situation? 

To help you judge how appropriate your utilisation of the five modes is for your situation, we have 
listed a number of uses for each mode - based upon lists generated by company presidents. Your 
score, high or low, indicates its usefulness in your situation.  It is, however, possible that your 
social skills may lead you to rely on some conflict behaviour more or less than necessary.  To help 
you determine this, we have also listed some diagnostic questions concerning warning signals for 
the overuse or underuse of each mode. 

 

 Competing 

Uses: 

1. When quick decisive action is vital - e.g. emergencies. 

2. On important issues where unpopular courses of action need implementing - e.g. cost 
cutting, enforcing unpopular rules, discipline. 

3. On issues vital to company welfare when you know you’re right. 

4. To protect yourself against people who take advantage of non-competitive behaviour. 
  

If you scored High: 

1. Are you surrounded by “yes” men? 

 (If so, perhaps it is because they have learned that it is unwise to disagree with you, or 
have given up trying to influence you.  This closes you off from information). 

2. Are subordinates afraid to admit ignorance and uncertainties to you? 



30 | P a g e  

 

 (In competitive climates, one must fight for influence and respect - which means acting 
more certain and confident than one feels.  The upshot is that people are less able to ask 
for information and opinion - they are less able to learn). 

 

If you scored Low: 

1. Do you often feel powerless in situations? 

 (It may be because you are unaware of the power you do have, unskilled in its use, or 
uncomfortable with the idea of using it. This may hinder your effectiveness by restricting 
your influence). 

2. Do you have trouble taking a firm stand, even when you see the need?  

 (Sometimes concern for others’ feelings or anxieties about the use of power causes us to 
vacillate, which may mean postponing the decision and adding to the suffering and or 
resentment of others). 

 

 Collaborating 

Uses: 

1. To find an integrative solution when both sets of concerns are too important to be 
compromised. 

2. When your objective is to learn - e.g. testing your own assumptions, understanding the 
views of others. 

3. To merge insights from people with different perspectives on a problem. 

4. To gain commitment by incorporating other’s concerns into a consensual decision. 

5. To work through hard feelings which have been interfering with an interpersonal 
relationship. 

 

If you scored High: 

1. Do you spend time discussing issues in depth that do not seem to deserve it? 

 (Collaboration takes time and energy - perhaps the scarcest organisational resources.  
Trivial problems do not require optimal solutions, and not all personal differences need to 
be hashed out.  The overuse of collaboration and consensual decision-making sometimes 
represents a desire to minimise risk - by diffusing responsibility for a decision or by 
postponing action). 

2. Does your collaborative behaviour fail to elicit collaborative responses from others? 

 (The exploratory and tentative nature of some collaborative behaviour may make it easy for 
others to disregard collaborative overtures:  or the trust and openness may be taken 
advantage of.  You may be missing some cues which would indicate the presence of 
defensiveness, strong feelings, impatience, competitiveness, or conflicting interests). 

 

If you scored Low: 

1. Is it difficult for you to see differences as opportunities for joint gain - as opportunities to 
learn or solve problems? 
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 (Although there are often threatening or unproductive aspects of conflict, indiscriminate 
pessimism can prevent you from seeing collaborative possibilities and thus deprive you of 
the mutual gains and satisfaction which accompany successful collaboration). 

2. Are subordinates uncommitted to your decisions or policies? 

 (Perhaps their own concerns are not being incorporated into those decisions or policies). 

 

 Compromising 

Uses: 

1. When goals are moderately important, but not worth the effort or potential disruption of 
more assertive modes. 

2. When two opponents with equal power are strongly committed to mutually exclusive goals -  
are in labour-management bargaining. 

3. To achieve temporary settlements to complex issues. 

4. To arrive at expedient solutions under time pressure. 

5. As a backup mode when collaboration or competition fails to be successful. 

 

If you scored High: 

1. Do you concentrate so heavily upon the practicalities and tactics of compromise that you 
sometimes lose sight of larger issues - principles, values, long-term objectives, company 
welfare? 

2. Does an emphasis on bargaining and training create a cynical climate of gamesmanship? 

 (Such a climate might undermine interpersonal trust and deflect attention away from the 
merits of the issues discussed). 

 

If you scored Low: 

1. Do you find yourself too sensitive or embarrassed to be effective in bargaining situations? 

2. Do you find it hard to make concessions? 

(Without this safety valve, you may have trouble gracefully getting out of mutually 
destructive arguments, power struggles, etc.)  

 

 Avoiding 

Uses: 

1. When an issue is trivial, of only passing importance, or when other more important issues 
are pressing. 

2. When you perceive no chance of satisfying your concerns - e.g. when you have low power or 
you are frustrated by something which would be very difficult to change (national policies, 
someone’s personality structure, etc.) 

3. When the potential damage of confronting a conflict outweighs the benefits of its 
resolution. 
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4. To let people cool down - to reduce tensions to a productive level and to regain perspective 
and composure. 

5. When gathering more information outweighs the advantages of an immediate decision. 

6. When others can resolve the conflict more effectively. 

7. When the issue seems symptomatic of another more basis issue. 

If you scored High: 

1. Does your co-ordination suffer because people have trouble getting your inputs on issues? 

2. Does it often appear that people are “walking on eggshells”? 

 (Sometimes too much energy is devoted to caution and to avoiding issues, indicating that 
issues need to be faced and resolved). 

3. Are decisions on important issues made by default? 

If you scored Low: 

1. Do you find yourself hurting people’s feelings or stirring up hostilities? 

 (You may need to exercise more discretion in confronting issues or be more tactful in 
framing issues in non-threatening ways.  Tact is partially the art of avoiding potentially 
disruptive aspects of an issue). 

2. Do you often feel harried or overwhelmed by a number of issues? 

 (You may need to devote more time to setting priorities - deciding which issues are 
relatively unimportant and perhaps delegating them to others). 

 

 Accommodating 

Uses: 

1. When you realise that you are wrong - to allow a better position to be heard, to learn from 
others and to show that you are reasonable. 

2. When the issue is much more important to the other person than to yourself - to satisfy the 
needs of others and, as a goodwill gesture, help maintain a co-operative relationship. 

3. To build up social credits for later issues which are important to you. 

4. When continued competition would only damage your cause - when you are outmatched 
and losing. 

5. When preserving harmony and avoiding disruption are especially important. 

6. To assist in the managerial development of subordinates by allowing them to experiment 
and to learn from their own mistakes. 

If you scored High: 

1. Do you feel that your own ideas and concerns are not getting the attention they deserve? 

 (Deferring too much to the concerns of others can deprive you of influence, respect and 
recognition.  It also deprives the organisation of your potential contributions). 

2. Is discipline lax? 
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 (Although discipline for its own sake may be of little value, there are often rules, 
procedures and assignments of which the implementation is crucial for you or the 
organisation). 

If you scored Low: 

1. Do you have trouble building goodwill with others? 

 (Accommodation on minor issues which are important to others is a gesture of goodwill). 

2. Do others often seem to regard you as unreasonable? 

3. Do you have trouble admitting to being at fault? 

4. Do you recognise legitimate exceptions to rules? 

5. Do you know when to give up? 

 

d. Outcomes Of Conflict 

The outcome of conflict will largely depend on the way people communicate in the 
process of dealing with the conflict. 

Outcomes are what you create 

Conflict may produce three distinct outcomes, depending on the approaches taken by the people 
involved.  

 

 The First Situation Is Termed ‘Lose-Lose’ (L- L) 

 

 

 

 

 

 

A conflict deteriorates to the point where both parties are worse off than they were before. An 
extreme example is the case of an executive who dismisses the only person who knows the secret 
formula for the organisation’s most successful product.  

 

 

 

 

 

  

Lose 

 

  

Lose 
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 The Second Outcome Is ‘Lose-Win’ (L – W) 

 

 

 

 

 

 

 

 

 

One person (individual A) is defeated while the other one (individual B) is victorious.  This is the 
outcome programmed in our minds when involved in conflict.  It is often conceptualised by 
managers who use power as a tool for managing conflict. 

 

 The Third Outcome Is ‘Win-Win’ 

 

 

 

 

 

 

 

Both parties perceive that they are in a better position than they were before the conflict began 
and the relationship is strengthened.  This is the ideal outcome to try to achieve. 

 

 When we approach situations with a win-win philosophy we tend to 
focus on 

 Compromise as disagreement is more costly 

 Involving all parties concerned and searching for mutual solutions 

 Preserving the relationship 

 Attempting to understand the other’s needs and objectives 

 The creation of a free flow of information 

 Emphasise common ground 

 Expressing outcomes in the positive. Moving towards something you want, rather than away 
from something you don’t want. (‘Satisfied clients’ rather than ‘Don’t disappoint the 
client’) 

  

Win 

 

  

Lose 

 

  

Win 

 

  

Win 
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e. The common consequences of unresolved conflicts: 

 

 The conflict often escalates in people’s minds 

 The unresolved conflict resurfaces each time a new conflict occurs 

 Strained relationships and mistrust develop 

 Prejudiced attitudes restrict the exchange of views and information 

 Co-operation suffers and opportunities are missed 

 Problems are not resolved and productivity suffers 

 The conflict expands to other people and cliques are formed 

 Performance declines and parties try to prevent one another from achieving their goals 

 In business situations the customer suffers and finds another supplier 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formative Assessments 1 
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SECTION 2: REPORTING 

 

Specific Outcome 2 

Read and report on transport operational information. 

 

Assessment Criteria 

 Basic computer skills are applied 
 Written communication is prepared 
 Language usage is explained 
 Reports are written in an accessible language 
 Analytical skills are developed 

 

2.1 Reports 

 

a. Definition 

A report, in whatever form, can be defined as follows: 

 

 

 

b. Purpose 

The purpose of a report is: 

 to convey information to another, and/or 
 to create a permanent record of the occurrence. 

Report is a comprehensive term for written information based on facts and can cover many 
topics.  A report is an objective, well-structured, written document based on accurate facts with 
the purpose of conveying specific, useful information to its readers.  A report is unique: no two 
reports are the same. 

In the business world, a report will usually be as a result of something that was investigated or 
researched, such as the implementing of a new computer system.  The custom in the organisation 
will determine whether the report is written in the formal or informal register. 

 

Reports usually consist of the following:  (see handout) 

 A cover page 

 A title page 

 Introduction and statement of the aim of the report, also called the terms of reference 

A report is a written, systematic account of the actions, observations and findings of 
the reporter on which he has based his deduction and opinions. 
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 A brief summary of the main contents 

 A table of contents 

 Procedure followed during the research or investigation 

 Findings and conclusions as a result of the research or investigation 

 Recommendations based on the research or investigation 

 bibliography 

 

c. The layout of a report 

 Introductory statement (terms of reference)  

State the aim of the report, who requested it and why it was done. 

 

 Summary of report 

Summarise the main contents of the report. 

1. Procedure 

2. Findings. 

3. Recommendations.  

 Table Of Contents 

 



38 | P a g e  

 

 

 Introduction 

This is your introductory paragraph, where you introduce the report to the reader 

 

 Procedure 

Here you will state the procedure(s) you followed to gather information, such as:  contacted the 
follwing computer wholesalers: 

 Abc trading 

 Xyz computers 

 Technical computer experts 

 

 Findings 

Here you will state your findings:  how much each quoted for the same kind of PC, what after sales 
service each company offers, what training they can provide or receommend, etc. 

 

 Conclusion 

 This will usually be a summary of your findings: 

 The kind of PC’s available 

 The prices 

 The training provided 

 After sales service, etc 

 

 Recommendations 

Your recommendations as to the kind of PC’s that the organisation should purchase, the prices, 
that should be paid, the training that should be provided to the staff. 

The purpose of a recommendation is to convince the reader to take a decision which the reporter 
deems the most suitable under the prevailing circumstances. 

In almost every report it is necessary for the reporter to make a recommendation, even if it was 
not requested for by the authority ordering the report to be submitted. 

It is useless to submit an unmotivated recommendation.  Such a recommendation is meaningless 
and carries no weight.  Should the writer recommend a specific action without indicating why he 
has considered it as the most suitable solution, he has missed his goal. 

 

 Appendices 

You will probably attach quotes and profiles of the companies for the reader to view. 

Annexures and appendixes which are attached to reports, must be numbered.  Annexures are 
numbered with capital letters of the alphabet and appendixes with Arabic numerals, ie  Annexure 
"A", "B" and Appendix 1 and 2.  The difference between an annexure and an appendix is that an 
annexure is a document without which the report would be incomplete..  An appendix is an 



39 | P a g e  

 

explanatory document with which the original writing would, in any case, be complete, viz a map 
of the surroundings. 

 

 Bibliography 

If you made use of books, magazine articles, etc in your research, quote you bibliography here. 
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Types Of Reports 

A report can also be defined as the presentation and interpretation of gathered information.    

In any organisation there is a need for information that has been gathered and compiled to be 
presented in such a way that everyone in the organisation can obtain the information they need 
without reading through piles and piles of information.  This is why a report is such an important 
feature in any organisation. 

The types of reports vary: 

 Financial reports such as budgets, cash flow statements, income and expenditure reports 
and balance sheets 

 Progress reports about projects, work in progress, team and group work 

 Reports that show  production figures 

 Reports that compare items, for example a comparison of various types of computer 
equipment that the organisation wants to purchase 

 Reports about absenteeism, annual leave, strikes and stay aways 

 Reports about inventory (stock) levels 

These are just a couple of the reports that can be required in an organisation.   

The timing of reports is also of importance.  Reports can be required: 

 Daily 

 Weekly 

 Monthly 

 Quarterly 

 annually 

 

d. Who needs reports and why? 

 Financial reports 

Financial reports are required by the financial department as well as the various departmental 
managers in the organisation.  They need to check the budget of the organisation as well as the 
individual departments in order to find out if the organisation is spending too much money or too 
little money. 

Similarly, the income and expenditure statement must be checked regularly to make sure that the 
organisation is not spending more money than it is earning. 

Balance sheets are usually compiled annually and forms part of the annual report of the 
organisation. The balance sheet and annual report contains information that is important to 
stakeholders of the organisation, such as shareholders, clients, creditors and even the employees 
of the organisation. 

The timing of the reports will vary: top management will probably only look at financial statement 
on a monthly, quarterly or six-monthly basis, while department and section managers will look at 
their financial statements on a weekly or even daily basis. 

 Progress Reports 

No project can be managed successfully without regular progress reports which will show if the 
activities that have to take place in order for the project to be completed on time are taking place 
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when they should be taking place.  The progress report will also highlight any problems in time so 
that corrective action can be taken to ensure that the project finishes on time. 

It is not only big projects that require progress reports, smaller tasks such as annual leave lists, 
productivity figures and so on also require progress reports. 

These reports are used by section and departmental managers and, of course, project managers, 
to track the progress of a task or a list of tasks.  Any problems that may occur can be identified 
early and important decisions, such as the purchasing of office equipment, can be made in time. 

 

 Production Reports 

In any manufacturing company, production is very important.  The section manager will look at the 
production figures on a daily basis and compare it to the tactical plan that contains the daily 
production figures required by the business.  

If the targets are not met, he can find out what the problem is and set it right as soon as possible.  
The departmental manager will probably look at the production figures on a weekly or monthly 
basis and the top management of the company will require monthly or quarterly production 
reports.  

 

e. What Are Reports Used For? 

 Information 

Top management will usually look at reports showing production figures or sales figures for 
information only.  They will use this information to find out if the organisation is meeting its goals 
and objectives.  They will also use this information to set the long- and medium term goals and 
objectives of the organisation. 

 

 Making Decisions 

Middle and junior management will also look at sales, inventory or production reports for 
information, but they will also use the information to make decisions.  If the production or sales 
figures are too low, middle and junior management have to investigate to find out where the 
problem is.  Then a decision has to be make about how to solve the problem. 

 

 Developing Action Plans 

Once a decision has been made, an action plan can be developed to either: 

 Solve the problem 

 Purchase the equipment 

 Introduce the new product 

 Change the policies and procedures of the company, depending on the purpose of the 
report. 
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2.2 Written Communication  

 

a.  Write Effectively 

 Plan what you are going to write 

 Who will you be writing for:  your friends and family, the general public, a business 
document, a newspaper or magazine article, etc. 

 In which register will you be writing the text: formal or informal 

 Which writing style will you use: narrative, discursive, expository, etc. 

 Will you write in the first person or the third person? 

 Determine the research you will do 

 Organise your writing: make sure ideas and facts flow logically 

 

 Make your writing interesting 

 Use punctuation correctly 

 Use titles, subtitles, headings, contents and index 

 Use an introduction and a conclusion 

 Use visual images and captions with these images 

 Vary the length of your sentences 

 Structure your paragraphs correctly 

 If any action is required, make suggestions about the actions 

 Put ideas forward 

 Use appendices or addenda if required 

 

 Diction 

 Choose words that are familiar and easy to understand 

 Make sure that you are using the correct words 

 Do not use technical language, legalisms, etc. when writing for the general public.  When it 
is a business document, use of technical terms and jargon will be acceptable 

 Do not use slang or write in dialect unless you are writing to entertain 

 

 Always 

 Be ethical: readers must be able to trust your writing 

 Quote facts and substantiate your facts with evidence so that the readers can believe you 

 Be sensitive to the reader’s point of view, culture, etc. 

 

 Bibliography 

A bibliography is a record of the resources and sources you used during your research.  Follow the 
following format when quoting the sources of your information: 
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 Author surname and initials 

 The year it was published 

 The title of the book 

 Where it was published 

 The name of the publisher 

 

When you quote the author directly, you have to add the following to your text where you use the 
quote: (Sayles & Chandler, 1971:185) 

 Sayles & Chandler are the authors 

 1971 is the year the book was published 

 185 is the page number where the quote appears 

Then, of course, you have to add the details of book to the bibliography. 

 

b. Checklist 

When you are gathering information, organising your material and considering your audience, it is 
a good idea to start with a checklist.   This will help to keep you focused so that you always bear in 
mind your purpose for writing, your audience and how to organise your writing. 

For example, if you want to write a report about the perception of HIV/AIDS among the students of 
the college, you could draw up a checklist for yourself, asking the following questions: 

 

Who is my audience?  

What style should I write in?  

What topics would I choose:  perceptions regarding testing for 
HIV/AIDS, prevention of HIV/AIDS, rights of people with HIV/AIDS, 
support for people with HIV/AIDS, etc 

 

What visual aids will I use?  

Where will I gather information?  

How will I organise information?  Will I start with the impact of 
HIV/AIDS on the family or the community or the workplace? 

 

And so on.  

 

You will use this checklist when you start writing the report to make sure that you keep to the 
subject and the interest of the audience. 
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c. Select The Format And Structure Of Your Text 

When you are writing a document for business, you always have to select the appropriate format.  
If a client writes to you to find out about a specific range of products or services, giving them a 
report of 20 pages about the advantages of wearing a specific shoe, will not help the client to 
decide which style or colour of shoe he wants.  You would rather send the client a brochure giving 
details of a range of shoes, with the available colours, sizes and uses.  Only if the client wants 
more details about a specific type of shoe will you think of sending a report. 

The structure of the text should also suit the specific document you are writing.  We do not usually 
include visual aids, slogans and sales hype in business letters –these are included in brochures and 
advertisements of the products. 

Each kind of business document has its own purpose and depends on what the client is asking you 
and what the purpose of the communication is. 

So, when you are writing a business document and you have to send it outside the company, before 
you start writing, consider: 

 The purpose of the writing 

 The needs of the client (the person who needs the report) 

 The type of business document you will use 

 The register: formal or informal 

 The style of writing 

 What information to include and what to leave out 

 

 

d. Identify Main Points 

Once again, consider: 

 The purpose of the writing 

 The needs of the audience, 

so that you can identify the main points of your writing.  Once you have identified the main points, 
you can add the supporting details.  Remember to structure your sentences, paragraphs and 
document in a logical manner.  

 

e. Visual Clues 

When writing a report, you should also use visual clues in order to emphasise, illustrate or explain 
certain points. 

 

 Diagrams 

A simplified drawing showing the appearance or structure of something. 
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This is a diagram of a human’s insides 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Tables  and graphs  

 

 

Below is an example of a table.   

Sales 

  Jan Feb Mar 

Item 1 1000 700 900 

Item 2 400 600 700 

Item 3 100 500 200 

Item 4 5000 7000 6000 

Totals 6500 8800 7800 

 

A table is a list where figures, facts or other information is given shortly. 
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Tables are more effective when shown in an appropriate graph or chart, as seen below. 

0

2000

4000

6000

8000

Item 1 Item 2 Item 3 Item 4

Sales Jan

Sales Feb

Sales Mar

 

 Captions 

A caption is a title or brief explanation that is printed with a visual aid, which can be a photo, an 
illustration, a diagram or a cartoon. 

 

The captions to the photos state: 

Mandela casts his vote in April and President Mandela joins hands with ex-President de Klerk. 

Can you see that you only have to look at the photos and the captions to find out what the article 
is about?  If you want more information, you would have to read the article, but you already have 
an idea what the article is about. 
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 Photographs And Other Graphics 

Authors use a wide range of visual images to enhance their text and to persuade the audience of 
their point of view.  Photos and other visual images such as graphs, cartoons, drawings, paintings, 
etc. are also used to give the reader visual clues about the written piece. 

 

f. Rewrite the first draft 

Once you have written the first draft, read through it at least two or three times.   

Make notes about the errors and changes you want to make as you go along: 

 Make sure that your use of grammar is correct and right for the audience.  

 Is your language clear enough? 

 Play around with the layout of your document: change the style of the headings, titles and 
font, move the visual aids around – do they look better this way or that way? 

 Check your use of technical language, legalese and jargon – will the audience understand 
your message? 

 Is your information presented in a logical way? 

 Are your facts correct?  Are you sure? 

Now rewrite the first draft, making the changes that you indicated. 

 

g. Pointers for all report writing 

 Be precise in your purpose or intention 

 Remember to include a Table of Contents 

 In the executive summary prove that your report is worthwhile studying 

 Be accurate, honest and objective. 

 Write as clearly and as correctly as possible. 

 Include relevant details and keep to the point.  Include additional information under the 
appendices. 

 Organise, prioritise and logically sequence events and facts and processes. 

 Take aspects into consideration that can influence the reader 

 Include a section to sign off on the report 

 Your style of writing should be impersonal and formal. 

The report can be stored for a number of years and used as a reference therefore it must be 
readable regardless of the audience, the time and the circumstances 
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2.3 Appropriate language  

The contents of a report must be concise and written in the first person.   

You have to develop a writing style that is direct and straightforward.  Although exceptions may 
sometimes be necessary, only one subject is to be dealt with in a particular report. 

Reports can sometimes be lengthy.  In such instances it is necessary to make use of headings and 
sub-headings.  It is also necessary to give a brief summary of the contents at the beginning of the 
report, to clearly outline the nature of the contents to the reader.  These particulars should, 
preferably, be given in the first paragraph. 

This learner guide has examples of headings and sub-headings. 

The contents of the report must be complete, comprehensive and brief, without 
discourteousness.  High-flowing terms, sarcasm, etc should be avoided at all times without being 
excessively humble, servile or insipid. 

 

 Write in a concise, simple, direct style and in the first person 

When writing a report, ensure that you keep the language you use simple, clear, understandable 
and to the point.   

Also, when writing a report you should do so in the first person. 

This means you reffer to yourself and what you experienced in the report. 

some industries or sectors have their own jargon (words and phrases used to illustrate industry 
specific matters). 

 

 The ten golden rules of meaningful written communication 

Correctness  grammar, spelling, punctuation, style, format and composition 

Conciseness  Brief, specific and to the point, include only what is really necessary. Don’t 
elaborate on facts and details. 

Completeness  Include all the relevant information you want to share as well as what the 
reader wants to know  

Clarity  Clarity and readability – choose words carefully to eliminate any assumptions 
and misinterpretations. 

Courtesy  be considerate of the readers, respect their feelings and their rights.  Test your 
approach by asking yourself; “Would I enjoy reading what I have written?” 

Simplicity Keep writing simple, use short yet detailed sentences, avoid using too many 
descriptive words ( adverbs and adjectives) 

Accuracy Always give accurate hones information – incorrect information can cost time 
and money. 

Concreteness  be realistic, positive, appeal to the readers by keeping their background, needs, 
and level of understanding in mind. 

Personality  the readers must know that you care about their interests 
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Sincerity  being sincere builds confidence, watch the tone of your writing, focus on expressing 
yourself clearly and creating a good 

 

 There are many reasons why authors write texts 

 To persuade readers to his/her point of view:  When an author is writing to persuade, he 
wants you to accept his opinion about issues, policies and situations. 

 To inform readers: in SA Computer you will find a lot of articles that inform readers about 
new developments in Information Technology.  In other magazines you will find fashion 
articles, articles about healthy eating and fitness, etc.  These articles were all written to 
inform readers. 

 To entertain readers:  the short stories found in magazines were written to entertain.  
Fables, fairy tales, fictional novels, cartoons, short, funny pieces in magazines were all 
written to entertain.   

 

 Before you start writing your text you have to plan what you are 
going to write 

 Who will you be writing/signing for:  your friends and family, the general public, a business 
document, a newspaper or magazine article, etc. 

 In which register will you be writing/signing the text: formal or informal 
 Which writing style will you use: narrative, discursive, expository, etc. 
 Determine the research you will do 
 Organise your writing: make sure ideas and facts flow logically 

 

 

 

 

 

 

 

 

 

 

 Pointers to think of before you write 

 If you are uncertain ask questions.  Do not make assumptions make sure your 
interpretation is correct. 

 Be well prepared.  If you have a clear understanding of what is required of you, your 
feedback will be more meaningful.  Know your topic or subject matter and you will 
command attention and respect.  

 Choose your words carefully as they not only express your thoughts, they also impress the 
receiver.  The impression your words make motivates the reaction you receive. 

 Think before you write.  Organise your thoughts and know what you want to say.  Don’t 
just ramble on.  Develop a logical pattern when putting pen to paper. 
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 Use clear simple language.  Select vocabulary that your audience will relate to and 
understand. 

 Be specific in your choice of words so that your message or information can be correctly 
interpreted.  Focus on what you want to say. 

 Give complete details- address all the relevant facts and answer all the questions and give 
the necessary explanatory information. 

 Apply the KISS rule (Keep it Short and Simple) too much unnecessary information can lead 
to reading boredom. 

 Focus on correctness.  Correct facts, correct answers, correct language usage, correct 
grammar, correct spelling, correct punctuation, correct format and style.  Always use a 
dictionary. 

 Be polite and considerate: respect the thoughts and opinions of others even if you do not 
agree. 

 Always try to write as you would speak.  Don’t make the written format too complicated. 
 Avoid using slang (its cool) make sure you use appropriate jargon and subject vocabulary 

that is relevant. 

 

 Make your writing interesting 

 Use numbers and bullets to separate ideas, facts and paragraphs.  You will find examples of 
bullets and numbers in this learner guide 

 Use punctuation correctly: commas, periods, etc. 
 Use titles, subtitles, headings, contents and index 
 Use an introduction and a conclusion 
 Use visual images and captions with these images 
 Vary the length of your sentences 
 Structure your paragraphs correctly 
 If any action is required, make suggestions about the actions 
 Put ideas forward 
 Use appendices or addenda if required 

 

 Remember: 

 People tend to accept factual evidence. 
 Work progressively and systematically through your reasoning to reach the point you want 

to make.  This approach could be convincing. 
 Take contrary arguments into consideration.  In the beginning mention both sides of the 

argument then focus on your reasoning.  Explain your reasoning carefully.  State your 
opinion and express your views yet acknowledge the contrary arguments even if you don’t 
agree.  

 

 All writing has: 

 a beginning where the main ideas, themes or key concepts are outlined. 
 a middle where these concepts are explained; arguments are developed and examples are 

discussed. 
 an end where the writer shows how the relevant points made in the beginning are related 

to the ideas outlined in the middle. 
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 Think about and remember 

 Always apply the process of unpacking and repacking when preparing any written task. 
 Brainstorm to unpack all the key information you need. 
 Then systematically develop this information into a mind map or flow diagram using 

questioning techniques to help you interpret the information correctly.   
 Next you sequence and restructure all the key issues you have included in your flow 

diagram.  
 Finally you repack (speak or write) this information in the required format e.g. a report, an 

assignment, a letter, a statement, a presentation, etc.   
 The document must be edited before it is submitted. 

 

 Rewrite your first draft 

 Writing and revising 

You will never use your first draft for the final document without reading and rereading and 
making changes. 

Your first draft is never good enough for the final product, you have to check and recheck and 
recheck again in order to make corrections to your writing that is an improvement on the original. 

You have unpacked all the information you require, maybe you used a mind map for this purpose.  You can 
refer to the mind map, or your notes,  and explain in detail what it is all about.  The next step is to put this 
information onto paper in the required format. 

 Keep in mind that you are speaking on paper to an audience. 
 Choose words and phrase carefully so that the meaning thereof is interpreted correctly. 
 Use the sequence you have identified in the mind map. 
 Develop each element consisting of a number of facts and ideas into a paragraph.   

A beginning where the main ideas, themes or key concepts are outlined 

A middle where these concepts are explained; arguments are developed and 

examples are discussed. 

An end where the writer shows how the relevant points made in the beginning are 

related to the ideas outlined in the middle. 
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 Then arrange these paragraphs into a pattern consisting of an introduction or beginning, a 
middle part and the conclusion or ending.  Note a paragraph is made up of a number of 
related sentences.   

 It has an introductory sentence that introduces the subject matter.   
 The body of a paragraph has a number of sentences that describe or inform the reader 

about the subject matter.   
 The conclusion is contained in the final sentences that either round the paragraph off or 

link it to the next paragraph. 
 

 It is important to edit  

or read over the final product before you submit it.  Decide how you must revise it by asking 
yourself:  

 Whether all the required aspects of the subject have been addressed? 
 If all the information is relevant 
 If you have achieved the purpose you had in mind? 
 Whether it will be suitable for the audience you have identified; Will they understand what 

you have written and will they be able to identify with the contents? 
 If the tone you have used is suitable to the audience? 
 If you your approach and writing style is user friendly approach 
 If the paragraphs link in a logical sequence 
 If your sentences are clear and easy to read and interpret? 
 Make sure your sentences are not too long or too short. 
 Is the vocabulary you have used applicable to the level of the audience? 
 Is the language polite and acceptable and without slang, jargon, clichés? 
 Make sure you have not repeated yourself. 

 

 When you are checking your document, check the following: 

 Your use of grammar.  
 Diction. 
 The sentence and paragraph structure. 
 If necessary, which it usually is, make changes to ensure consistency. 
 Ensure that your ideas and topics flow logically from one to the other in the sentences as 

well as the paragraphs. 
 Identify and remove inappropriate or potentially offensive language.   
 Be on the lookout specifically for jargon and technical language.  Don’t use them too much, 

replace them with other explanatory words.  Too much jargon and technical language 
confuses a reader who is not familiar with it.  The reader will lose interest and stop 
reading.  I am sure you have stopped reading an article or document because of excessive 
use of jargon and technical language. 

 Beware of using offensive language with regards to gender, rank, family, sports and wealth  
 You might find a sexist joke funny, the other party might not.  Do not make fun of a 

person’s gender or rank.  Also, do not refer to “that old woman”, she might be someone’s 
mother.  Do not call your boss the “Big Chief”, call him by his proper rank.   

 Experiment with the layout of your writing/signing:  change the headings, change the font 
type and size, move the pictures around until your writing looks pleasing to the eye 

 

 Jargon 

Words or expressions that are used by a specific trade, business or industry 



53 | P a g e  

 

 A paper tiger: when a committee or other body is established to investigate an occurrence, 
and nothing much happens, it is called a paper tiger.  It means that the committee is not 
doing what it is supposed to do, the members of the committee postpone actions and make 
up imaginary problems as to why they cannot do the work in time. 

In the training environment in South Africa we find a lot of jargon – words that are used in a 
context not previously used and existing words put together to mean something that is unique to 
the education and training environment.  We talk about Unit Standards, which previously was 
called training courses, we talk about assessments rather than tests and we have standards 
generating bodies and standards governing bodies, and so on. 

 

 Obfuscation 

 

 

Authors who do this cloud the issue in order to avoid taking responsibility for an action or to 
confuse the listener/viewer into accepting something that should not be lightly accepted  

 

 Insensitive choice of words 

Be careful of words, sentences and paragraphs that may appear insensitive or give offence, 
especially regarding the following topics: gender, rank, hierarchies in familiar settings or 
organisations, family, sports, wealth.   

Do not make fun of rich or poor people, do not make fun of people based on their gender, etc. 

 

 

2.4 Computers In Road Transport 

a. Introduction  

Computers have become an integral part of business.  It is used for basic communication, 
information management and storage, business calculations and much more. 

These amazing machines can do wonderful things, but it can only do what the operator tells it to 
do.  Most computer errors occur between the chair and the keyboard/mouse – think about that. 

Computers have been successfully implemented in road transport operational management, 
including all the activities involved therein. (Supply chain management, marketing, financial 
management, etc.)  In addition to operational application, computers are also used for 
administration. (Correspondence, invoicing, etc.) 

 

b. Word processing  

Written communication like letters, memos, notices, etc. can be produced using a word processing 
programme like MS Word or Word Perfect. A word processing program is a program that allows you 
to type various documents, for example: 

 A letter to a friend  
 Or a business letter 

Note Obfuscation is the deliberate use of words/signs/phrases/jargon/idioms that will 
not be understood by the listener/reader/viewer. 
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 Or a school project 
 Or a menu for a special function 
 Or a report 
 Or minutes of a meeting 

In other words, a word processing program allows you to type various documents on your 
computer!   

 

 Benefits 

 You can change the appearance of your document without retyping the entire document 
 You can add colour, pictures, tables and even text effects to your document 
 A word processing programme such as MS Word also has the benefit that you can check 

spelling and grammar while you are creating your document 
 It is easy to correct mistakes 
 Word processing programmes have templates of correspondence that is used often, such as 

fax cover sheets, that you can use for all your faxes.  You then only fill in the areas that 
have changed 

Written communication and the presentation thereof can be seen as an extension of the company’s 
corporate image.  Features of these applications assist with formatting and editing, increasing 
professionalism. 

 

 Start MS Word 

Once Word has been installed on your computer you can start the application by: 

 On the Taskbar, click the Start button then select the All Programs menu item. 
 The All Programs submenu is displayed. 
 Click the Microsoft Office program item 
 Click the Microsoft Word program item 

The Microsoft Word window opens on your desktop. 

 

 
 

 

 

 



55 | P a g e  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The MS Word Application Window 
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 The Title Bar 

The Title bar is where we find the name of the program as well as the 
document we are working in. Since you have not yet done any work, 
the document is simply called Document 1 

Also note that Undo, Redo and Save has moved from what used to be the File menu in previous 
versions of MS Word  to the Title Bar in Office2007 and  2010.   

 

 The Ribbon  

The ribbon displays tabs.  The tabs contain the commands available in Word. You choose 
commands to perform tasks in Word. 

 

The commands are displayed in groups: 

The Home tab displays the following groups: 

 Clipboard 
 Font 
 Paragraph 
 Styles 
 Editing 

 

To switch between the Tabs, simply click on them, for example click on the Home tab to open it, 
or the View tab to open it.  

 

 Rulers 

The rulers enable you to plot where you are in your document, as well as where to place items 
such as pictures 

 

 

 Scroll Bars 

Scroll bars are used to view parts of the workbook that are not visible. 
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 Status Bar  

The Status Bar is situated at the bottom of the Word screen and  which shows you what is 
happening in your document. 

 

 

 Closing The Word Desktop Or Window 

There are various ways of closing the Word Window, the easiest one is to click on the cross X in the 
top right hand corner of the desktop:  

If you have made changes to your documents since you last saved it, the 
following message will appear: 

 

 Click on Yes to save the changes. 
 If this is the first time you are saving the document, the Save As  window will appear 
 Select a name for your documents and click on Save 
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If you have saved the document previously, Word will automatically save the changes and then 
close the window.  

 You can also close the Word window by selecting the File tab button and clicking the Exit 
button 
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 Create A New Document 

Your Workspace 

 In the centre of your Word window is a white rectangle. This is where you will type your 
document.  

 In the top left hand corner, of the page you will see a blinking black line. This is called the 
cursor and this blinking line will always be where you start typing. The cursor moves along 
the page as you type. 

 Rulers show you where you are on the page. 

 

 

 Typing A Document 

 

 

Type the following text in your document: 

There is only one thing you can do with time, spend it. How you spend your time will directly 
affect your success. Each person on earth is given the same 24 hours each day. Have you noticed 
how some people get more done than others in the same 24 hours? 

 

 Saving A Document 

Naming Your Document 

When you create and save a new document, you have to take care that you: 

 Give the document an appropriate name 
 Save it in the correct folder 

When naming a document in Word, you must follow the same conventions as when you name a 
document in the workplace.  Do not give the document silly names such as: Annatjie’s document or 
letter dated 7 September.   

Cursor 

Exercise 
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In your workplace you will have certain filing conventions that have to be followed, e.g. the 
client’s name, followed by the date or even the kind of letter you are creating:   

 BMW quote 7 Sep 
 Telkom account query 3 Feb 2005 
 XYZ Traders order 7 July 2005 

When you save your document, you must also follow the filing rules of your workplace.  If you have 
a filing cabinet at work, and correspondence for XYZ Trading is filed in a drawer, in a folder named 
XYZ trading, you must do the same on your computer.  You will have to open a folder called XYZ 
Trading in your My Documents folder and then save all the correspondence relating to this 
customer in that folder. 

Save Your Document 

Now you must Save your document to make sure that it is not lost when you exit out of Word.  At 
the moment your document is called:   

Document 1   As you can see in title bar of the Word window. 

 

 To save your typed document, click on the Save button (in the top left corner) and the Save 
As window menu will appear. 

 Give your document a suitable name – in this case, give the following name: Practice 
followed by your name 

 Click on the down arrow next to the Save As dialogue box to see all the formats you can 
save the document in 

 Select Word Document and your document will be saved with the name you selected 
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 Save your document as practice followed by your name. 
 Close the document 
 Exit MS Word 
 Open MS Word 
 Find your document and open it 

 

 Work with fonts 

Font is the term used (in Word) to describe the typeface of text (the shape of the characters). 
Word provides many built-in fonts that can be applied to text. You may find that the fonts 
available vary depending on what software you have installed. 

 

 

Too many different typefaces and enhancements can have the opposite effect. 

There are three important kinds of typeface: 

 Serif type has curly edges to help guide the eye, like the text in this paragraph. Serif type is 
suitable for large blocks of text. Examples include Times New Roman and Book Antiqua. 

 Sans serif type is plainer looking, like the text in the heading at the top of this page. Sans 
serif type is suitable for smaller blocks of text, such as text in columns and headings and in 
some cases for documents intended to be read on-screen. Examples include Arial, Gill Sans, 
and Tahoma. 

 Cursive type is designed to look like handwriting. It should be used sparingly. 

Exercise 
 

Mixing fonts (typefaces) and applying enhancements - varying size with bold, underline, 
and italics - can emphasise key points in a document or make titles stand out. 
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Use a typeface appropriate to the type of documents you are creating. Look at other books, 
letters, and magazines to guide you. 

 

 Change The Font Type And Size 

You can change the way the letters look in your documents. We call this changing the font. Word 
offers a wide variety of fonts to choose from. 

 To change the font, choose the font type by clicking on the arrow next to the Font Type 
icon on the Home Tab.  Scroll up and down to view the choices available.  You can use the 
arrows or the bar to scroll up and down. 

 To change the size of the font, click on the arrow next to the Font size icon. Choose the 
font size you want by scrolling up and down. Normal text is usually between 10 and 12 and 
the larger the number, the larger the font will be. 

 

 

 

 Change The Style Of The Text 

The Home Tab mostly enables you to change the appearance of your text.  You can make words 
stand out by underlining them, changing their size, changing their colour, etc. 
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 You always have to tell the computer what to do. This is also true if you want to format text 
- you have to tell the computer which words you want to change! 

 When you tell the computer that you want to change the text style, you can do this either 
before you start typing or after you have finished typing. 

 

 Format text before you start typing  

Choose the formatting by clicking on the icon, and then type the text. When an icon is in use, it 
will be highlighted. Remember, to switch off the text attribute, you have to click on the same 
icon again.  

 

 

 

 

 Format text after you have typed your text  

Select the text you wish to change. You do this by clicking and dragging the mouse over it. The 
text will then look different to the rest of the document, to show that it has been highlighted. 
Then you click on the icon to select the formatting:  

B  Bold 

I  Italics 

U  Underline 

 

 Change The Colour Of Text And Numbers  

Select the text you want to change.  
Do one of the following:  
 To apply the colour most recently used for text, click on the Home Tab, Font Colour on the 

Font group.  
 To apply a different colour, click the arrow next to the Font Colour button, and then select 

the colour you want.  
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 Highlight Important Text  

 On the Font group, click Highlight  
 Select the text or graphic you want to highlight. 
 Select the next item in the document that you want to highlight.  
 To turn off highlighting, click Highlight again, or press ESC 

 

 Undoing And Redoing Incorrect Edits 

Undo Edits 

Word allows you to undo previous action(s). If you make a mistake or series of errors, it is often 
quicker to undo and start again rather than trying to correct the mistake. 

 To undo the last action 
 On the Title bar, click Undo 

To Undo Previous Actions 

The Undo button stores over 300 actions. 

 Click the arrow on the Undo button to display a list of your previous edits 
 The Undo menu is displayed. 
 Select the edit you want to undo from the scrollable list 

 

 Warning:  All of the edits back to that point are undone in one action. You cannot pick 
an edit from the menu - you must undo all the edits between the point you are at and 

the point to which you want to return. 
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Redo Edits 

The Redo button stores all of the edits you have just undone, until you make a change normally, 
when they are forgotten.  

 

To redo the last action: 

 On the Office toolbar, click Redo to redo previous actions 
 Click the arrow on the Redo button to display a list of edits you have undone 
 Select the edit you want to redo up to from the scrollable list 
 All of the edits forward to that point are redone in one action. 

 

 

 

 

Spreadsheets 

Spreadsheets are used for recording and manipulation of data.  It is especially suited for 
mathematical functions and financial calculation.  Data is entered into cells on the spreadsheet.  
These cells (or groups of cells) can be programmed to perform certain operations and/or 
calculations. 

Spreadsheets are valuable as they can store and manipulate vast volumes of data. 

Excel is a spreadsheet program.  
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The desktop displays many cells in rectangular grid that consists of rows and columns. 

The word "spreadsheet" came from "spread" in its sense of a newspaper or magazine item (text 
and/or graphics) that covers two facing pages, extending across the center fold and treating the 
two pages as one large one.  

The compound word "spread-sheet" came to mean the format used to present book-keeping 
ledgers: 

 with columns for categories of expenditures across the top,  
 invoices listed down the left margin,  
 and the amount of each payment in the cell where its row and column intersect, which 

were, traditionally, a "spread" across facing pages of a bound ledger (book for keeping 
accounting records) or on oversized sheets of paper ruled into rows and columns in that 
format and approximately twice as wide as ordinary paper. 

 

 

 

A spreadsheet will add long columns or rows of figures for you.  You can also do other calculations, 
such as determining the average of a row of figures, calculating interest or finding out the 
minimum or maximum values of a row or column of figures.  

Once you have calculated the value of a row or column of figures, e.g. the average, and you make 
changes to any of the numbers, the value will be changed to the new value automatically. 

In a spreadsheet application, each value (the numbers you are working with) sits in a cell.when you 
are working on the spreadsheet, you define the type of data in each cell and how the different 
cells depend on each other.  

 

 

 

 

The first thing therefore is to define the cells and the formulas for linking them together.  Now you 
will enter the data you want to manipulate 

A simple example of a useful spreadsheet application is one that calculates mortgage payments for 
a house. You would define five cells:  

1. total cost of the house  

2. down payment  

3. mortgage rate (the interest rate) 

4. mortgage term (the number of years or months in which you will repay the house) 

5. monthly payment  

You have now defined how the cells depend on each other and now you can manipulate the data: you could 
change the interest rates to find out how that will affect your monthly payments, or you could change the 
amount of the housing loan to find out how  

Once you had defined how these cells depend on one another, you could enter numbers and play with 
various possibilities. For example, keeping all the other values the same, you could see how different 

Note:  A spreadsheet is a computer application (software program) that looks like a 
paper accounting worksheet. 

 

Tip:  An electronic spreadsheet program can be used for storing, organising and 
manipulating data. 

 

Tip:  The relationships between cells are called formulas (for example multiply or 
add the values of two or more cells), and the names (invoice number or amount, etc.) 

of the cells are called labels. 
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inbterest rates would affect your monthly payments or how different monthly payments will affect 
your repayment term.   

You can therefore study various “what if” scenarios 

In short, Excel will automate repetitive calculation tasks for you by,f or example, adding 
rows or columns of figures. 

The basic working environment in Excel is a workbook that can contain one or more worksheets.  

 

 

 

We have said that a worksheet is similar to an accountant’s ledger, with numbers; text and 
calculations lined up in columns and rows.  However, unlike in an accountant’s ledger, Excel will 
do the calculations for you. 

Excel also makes it easier for you to change, delete or add information. You can also arrange 
multiple worksheets within a workbook – for example, you can place all the worksheets for one 
client in one workbook. 

 

 The Excel Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Excel 2010 has a results-oriented user interface, making it easier for you to perform tasks in Excel.  
The features of the Excel window include: 

Tip:  Remember, in Word we spoke about a document - in Excel it is called a 
worksheet. 
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 Quick Access Toolbar 

This customizable toolbar allows you to add frequently used 
commands. Click on the down arrow at the end of the 
toolbar to display the toolbar's options. 

 

 

 

 

 

 

 

 

 

 

 Title Bar  

The Title bar is where we find the name of the program as well as the document we are working 
in – the Quick Access Toolbar is situated on the Title Bar 

 

 

 Ribbon 

The Ribbon is the strip of buttons and icons located above the work area. The Ribbon is organized 
into a series of tabs - such as File, Home, and Formulas. Each tab contains a number of related 
features and options. First introduced in Excel 2007, the Ribbon replaced the menus and toolbars 
found in Excel 2003 and earlier versions. 

 

 

 File Tab 

The File tab is new to Excel 2010 - Sort of. It replaces the Office Button that was 
found in Excel 2007 and also the File menu from older Excel versions 

Like the old file menu, the File tab options have to do with file management, e.g.  
opening new or existing worksheet files, saving, printing 

 

 

 

 

Tip A new feature – has been added: saving and 

 sending Excel files in PDF format 
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 Formula bar 

It is situation directly above the 
worksheet. This area displays the 
contents of the active cell. It is also 
used for entering or editing data and 
formulas into the active cell. 

 

 

 

 Name Box 

This is situated right next to the formula bar and displays the cell reference or 
the name of the active cell.  

 

 

 

 

 

 Scroll bars 

Scroll Bars: are used to view parts of the workbook that are not visible. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scroll up 
arrow 

Scroll  
button 

Scroll down 
arrow 

Browse  
buttons 

Browse  
selector 
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Active cell 

The active cell is recognized by its black outline. Data s always entered into the active cell. 
Different cells can be made active by clicking on them with the mouse or by using the arrow keys 
on the keyboard.  

 

 Column headings or letters 

Columns run vertically on a  worksheet and each one is identified by a letter in the column header.  

 

 Row headings or numbers 

Rows run horizontally in an Excel 2010 worksheet and are identified by a number in the row 
header. 

 

 Sheet tabs 

Switching between worksheets in an Excel 2007 file is done by clicking on the sheet tab at the 
bottom of the screen. 

 

 Windows Taskbar 

This is a part of Windows and displays the buttons of the programs, which have been opened, as 
well as the time and the Start button. 

 

 Status Bar 

A horizontal bar at the bottom of the screen that displays information about the current condition 
of the program, such as the status of items in the window, the progress of the current task, or 
information about the selected item.. 
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 Start Excel 

First, you must start Excel. Click the Start button, point to All 
Programs, select Microsoft Office and then click on Excel  

The Excel desktop, with a blank worksheet pops up on your 
screen. Do this now, so that you can see what the Excel desktop 
looks like. 
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 Select cells, ranges, rows, or columns 

To select Do this 

A single cell Click the cell, or press the arrow keys to move to the cell. 

A range of cells Click the first cell in the range, and then drag to the last cell, 
or hold down SHIFT while you press the arrow keys to extend 
the selection.  

A large range of cells Click the first cell in the range, and then hold down SHIFT 
while you click the last cell in the range. You can scroll to 
make the last cell visible. 

All cells on a worksheet Click the Select All button.  

 

To select the entire worksheet, you can also press CTRL+A.  

Note: If the worksheet contains data, CTRL+A selects the 
current region. Pressing CTRL+A a second time selects the 
entire worksheet. 

Nonadjacent cells or cell 
ranges 

Select the first cell or range of cells, and then hold down CTRL 
while you select the other cells or ranges.  

Note: You cannot cancel the selection of a cell or range of 
cells in a nonadjacent selection without canceling the 
entire selection. 

An entire row or column Click the row or column heading.  

 

Row heading 

Column heading 

You can also select cells in a row or column by selecting the 
first cell and then pressing CTRL+SHIFT+ARROW key (RIGHT 
ARROW or LEFT ARROW for rows, UP ARROW or DOWN ARROW 
for columns). 
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Adjacent rows or columns Drag across the row or column headings. Or select the first row 
or column; then hold down SHIFT while you select the last row 
or column. 

Nonadjacent rows or 
columns 

Click the column or row heading of the first row or column in 
your selection; then hold down CTRL while you click the 
column or row headings of other rows or columns that you 
want to add to the selection. 

The first or last cell in a 
row or column 

Select a cell in the row or column, and then press 
CTRL+ARROW key (RIGHT ARROW or LEFT ARROW for rows, UP 
ARROW or DOWN ARROW for columns). 

The first or last cell on a 
worksheet or in a Microsoft 
Office Excel table 

Press CTRL+HOME to select the first cell on the worksheet or in 
an Excel list.  

Press CTRL+END to select the last cell on the worksheet or in 
an Excel list that contains data or formatting. 

Cells to the last used cell 
on the worksheet (lower-
right corner) 

Select the first cell, and then press CTRL+SHIFT+END to extend 
the selection of cells to the last used cell on the worksheet 
(lower-right corner). 

Cells to the beginning of 
the worksheet 

Select the first cell, and then press CTRL+SHIFT+HOME to 
extend the selection of cells to the beginning of the 
worksheet. 

More or fewer cells than 
the active selection 

Hold down SHIFT while you click the last cell that you want to 
include in the new selection. The rectangular range between 
the active cell and the cell that you click becomes the new 
selection. 

 

 Notes 

 To cancel a selection of cells, click any cell on the worksheet. 
 Excel marks selected cells or ranges by highlighting them. These highlights do not appear in 

a printout. If you want to display cells with a highlight when you print a worksheet, you can 
use formatting features to apply cell shading.  

 If the selection is extended when you click a cell or press keys to move around, it may be 
because F8 or SHIFT+F8 have been pressed to extend or add to the selection, displaying 
Extend Selection, or Add to Selection on the status bar: To stop extending or adding to a 
selection, press F8 or SHIFT+F8 again. 
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 Select the contents of a cell 

To select the contents of a cell Do this 

In the cell Double-click the cell, and then drag across the contents of 
the cell that you want to select.  

In the formula bar: 

  

Click the cell, and then drag across the contents of the cell 
that you want to select in the formula bar. 

By using the keyboard Press F2 to edit the cell, use the arrow keys to position the 
insertion point, and then press SHIFT+ARROW key to select 
the contents. 

 

 

 

 Select rows and columns in an Excel table 

To select Do this 

A table column 
with or without 
headers 

Click the top edge of the column header or the column in the table. 
The selection arrow will appear to show you that clicking selects the 
column.  

You can also click anywhere in the table column, and then press 
CTRL+SPACEBAR,  

A table column 
with worksheet 
headers  

Click the worksheet column heading that displays the table header of the table 
column that you want to select.  

OR 

You can also click anywhere in the table column, and then press 
CTRL+SPACEBAR. 
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A table row Click the left border of the table row. The following selection arrow 
will appeat to show you that clicking selects the row.  

All table rows 
and columns 

Click the upper-left corner of the table. The following selection 
arrow appears to indicate that clicking selects the entire table.  

You can also click anywhere in the table, and then press CTRL+A, or you can 
click the top-left most cell in the table, and then press CTRL+SHIFT+END. 

 

 Select one or multiple worksheets 

By clicking the tabs of worksheets (or sheets) at the bottom of the window, you can quickly select 
a different sheet.  

 

 

You can also format or print a selection of sheets at the same time. 

 

To select Do this 

A single sheet Click the sheet tab.  

 

If you don't see the tab that you want, click the tab scrolling buttons to 
display the tab, and then click the tab. 

 

Two or more adjacent 
sheets 

Click the tab for the first sheet. Then hold down SHIFT while you click 
the tab for the last sheet that you want to select. 

Two or more 
nonadjacent sheets 

Click the tab for the first sheet. Then hold down CTRL while you click 
the tabs of the other sheets that you want to select. 

All sheets in a 
workbook 

Right-click a sheet tab, and then click Select All Sheets on the shortcut 
menu. 

 

Note If you want to enter or edit data on several worksheets at the same time, 
you can group worksheets by selecting multiple sheets. 
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 Notes 

 Group: When multiple worksheets are selected, [Group] appears in the title bar at the top 
of the worksheet. To cancel a selection of multiple worksheets in a workbook, click any 
unselected worksheet. If no unselected sheet is visible, right-click the tab of a selected 
sheet, and then click Ungroup Sheets on the shortcut menu. 

 Data that you enter or edit in the active sheet is reflected  
 Shortcut menu: A menu that shows a list of commands relevant to a particular item. To 

display a shortcut menu, right-click an item or press SHIFT+F10 
 Active sheet: The sheet that you're working on in a workbook. The name on the tab of the 

active sheet is bold. 
 

 Use the arrow keys to move through a worksheet 

To move between cells on a worksheet, click any cell or use the arrow keys. When you move to a 
cell, it becomes the active cell 

To scroll Do this 

To the start and end of ranges Press CTRL+ARROW key to scroll to the start and end of each 
range in a column or row before stopping at the end of the 
worksheet.  

To scroll to the start and end of each range while selecting the 
ranges before stopping at the end of the worksheet, press 
CTRL+SHIFT+ARROW key. 

One row up or down Use the UP ARROW key or DOWN ARROW key to scroll one row 
up or down. 

One column left or right Use the LEFT ARROW key or RIGHT ARROW key to scroll one 
column left or right. 
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One window up or down Press PAGE UP or PAGE DOWN. 

One window left or right Press SCROLL LOCK, and then hold down CTRL while you press 
the LEFT ARROW or RIGHT ARROW key. 

A large distance Press SCROLL LOCK, and then simultaneously hold down CTRL 
and an arrow key to quickly move through large areas of your 
worksheet. 

 

 

 

 Use the scroll bars to move through a worksheet 
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To scroll Do this 

One row up or down Click the scroll arrows or on the vertical scroll bar to move 
the sheet one row up or down.  

One column left or right Click the scroll arrows or on the horizontal scroll bar to 
move the sheet one column to the left or right. 

Scroll through a worksheet 
with increased scroll speed 

While scrolling, hold down the mouse at the farthest end of the 
screen for more than 10 seconds to increase the scrolling speed.  

Moving the mouse in the opposite direction slows down the scroll 
speed. 

One window up or down Click above or below the scroll box on the vertical scroll bar. 

One window left or right Click to the left or right of the scroll box on the horizontal 
scroll bar. 

A large distance Hold down SHIFT while dragging the scroll box . 

 

 Notes 

 When you use the scroll boxes to move through a worksheet, Excel displays a tooltip to 
indicate row numbers or column letters (or numbers if you specified to use R1C1 reference 
style for the workbook) so that you know where you are in the worksheet.  

 The size of a scroll box indicates the proportional amount of the used area of the sheet that 
is visible in the window. The position of a scroll box indicates the relative location of the 
visible area within the worksheet.  

 You can quickly split the window so that you can scroll in two or four panes 
simultaneously. Point to the split box on either the vertical or the horizontal scroll 

bar. When the pointer becomes a double-headed arrow , drag the split bar onto 
the worksheet where you want to split the window. Double-click the split bar to remove it. 
 
 
 
 

 Scroll and zoom by using the mouse 

Some mouse devices and other pointing devices, such as the Microsoft IntelliMouse pointing device, 
have built-in scrolling and zooming capabilities that you can use to move around and zoom in or 
out on your worksheet or chart sheet. . You can also use the mouse to scroll in dialogue boxes that 
have drop-down lists with scroll bars. For more information, see the instructions for your pointing 
device. 
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To Do this 

Scroll up or down a few rows at a time Rotate the wheel forward or back. 

Scroll through a worksheet with 
increased scroll speed 

While scrolling, hold down the mouse at the farthest 
end of the screen for more than 10 seconds to increase 
the scrolling speed.  

Moving the mouse in the opposite direction slows down 
the scroll speed. 

Pan through a worksheet Hold down the wheel button, and drag the pointer 

away from the origin mark in any direction that you 
want to scroll. To speed up scrolling, move the pointer 
away from the origin mark. To slow down scrolling, 
move the pointer closer to the origin mark. 

Pan through a worksheet automatically Click the wheel button, and then move the mouse in 
the direction that you want to scroll. To speed up 
scrolling, move the pointer away from the origin mark. 
To slow down scrolling, move the pointer closer to the 
origin mark. To stop automatic scrolling, click any 
mouse button. 

Zoom in or out Hold down CTRL while you rotate the IntelliMouse 
wheel forward or back. The percentage of the zoomed 
worksheet is displayed on the status bar. 

Show detail in outlines Point to a cell that summarizes data in the outline, and 
then hold down SHIFT while you rotate the wheel 
forward. 

Hide detail in outlines Point to any cell that contains detail data, and then 
hold down SHIFT while you rotate the wheel back. 

 

 

 

Practice the selecting of cells by means of the above methods for about 5 minutes, or until you are 
familiar with the procedure. 

 

 Enter data into cells 

When you open a new worksheet, all the cells have general format. The format of the cell 
determines what the numbers, text, dates and so on in the cell look like after you have entered 
data into a cell.  

Exercise 
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Entering data into cells 

When you type numbers into a cell, they are automatically aligned to the right. If the number is 
too long, Excel will automatically widen the column. To enter a negative amount, either type a 
minus  (-) before the amount or enclose it within a parentheses (1234).  

Protected worksheet 

A worksheet may have been protected by you or someone else to prevent data from being changed 
accidentally. On a protected worksheet, you may be able to select cells to view the data, but you 
won't be able to type information in cells that are locked.  

In most cases, a protected worksheet should not be unprotected unless you have permission to do 
so from the person who created it. If a password was set when the worksheet protection was 
applied, you must type that password to unprotect the worksheet. 

 

 Enter numbers or text 

 On the worksheet, click a cell.  
 Type the numbers or text that you want, and then press ENTER or TAB.  
 To start data on a new line within a cell, enter a line break by pressing ALT+ENTER. 

 

 

 

 

 Change the column width 

When a cell displays the following, ######  it means that the data in the cell is wider than the 
width of the column. To see all the text, you have increase the width of the column.  

 Click the cell for which you want to change the column width.  
 On the Home tab, in the Cells group, click Format.  
 Under Cell Size, do one of the following:  

 To fit all text in the cell, click AutoFit Column Width.  
 To specify a larger column width, click Column Width, and then type the width that you 

want in the Column width box. 

 

 

 

 

 

 

 

 

 

 

 

Note: By default, pressing ENTER moves the selection down one cell, and pressing TAB 
moves the selection one cell to the right. 
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 Wrap text in a cell 

You can display multiple lines of text inside a cell by wrapping the text: 

 Click the cell in which you want to wrap the text.  
 On the Home tab, in the Alignment group, click Wrap Text.  

 

 

 Notes 

 If the text is a single long word, the characters won't wrap.  In this case you can widen the 
column or decrease the font size to see all of the text. 

 If not all of the text is visible after you wrap the text, you may need to adjust the height of 
the row. On the Home tab, in the Cells group, click Format, and then under Cell Size click 
AutoFit Row. 

 In Microsoft Office Excel, the appearance of a number in a cell is separate from the number 
that is stored in the cell. When a number that you enter is rounded, in most circumstances, 
only the displayed number is rounded. Calculations use the actual number stored in the cell, 
not the number that is displayed.  
 

 Change the number format 

It is possible to change the format in which numbers are displayed in the cell once you have typed 
the numbers into the cell. 

 Click the cell that contains the numbers that you want to format.  
 On the Home tab, in the Number group, point to General, and 

then click the format that you want.  

 

 

 

 

 

 

 

 

 To select a number format from the list of available formats, 
click More, and then click the format that you want to use in the 
Category list. 
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 Format numbers as text 

At times you will work with numbers, such as phone numbers and postal codes, that you will not 
use in calculations.  In this case you have to change the formatting of the numbers to text before 
you type the number in the cell. 

 Select an empty cell.  
 On the Home tab, in the Number group, point to General, and then click Text.  
 Type the numbers that you want in the formatted cell.  

 

 

 

 

 Enter dates or times 

 On the Home tab, in the Number group, point to General, and then select either short date 
or long date. 

 Add the date 

OR 

On the worksheet, click a cell and type a date or time as follows:  

 For a date, use a slash mark or a hyphen to separate the parts of a date; for example, type 
9/5/2002 or 5-Sep-2002.  

 To enter the current date, press CTRL+; (semicolon). 
 To enter the current time, press CTRL+SHIFT+; (semicolon). 

 

 

 

 

 Notes 

 When a date or time is typed in a cell, it appears either in a default date or time format or 
in a format that was applied to the cell before the date or time was entered. The default 
date or time format is based on the date and time settings in the Regional and Language 
Options dialogue box (Control Panel). If these date and time settings have changed, any 
existing dates or times in your workbooks that have not been formatted by using the Format 
Cells command also change.  
 

 Edit cell contents 

You can edit the contents of a cell directly in the cell. You can also edit the contents of a cell in 
the formula bar  

 Double-click the cell that contains the data that you want to edit.  

OR 

 Click the cell that contains the data that you want to edit, and then click anywhere in the 
formula bar.  

This positions the insertion point in the cell or formula bar. 

Note: Numbers that you typed before you applied the Text format to the cells need to be 
reentered in the formatted cells. To quickly reenter numbers as text, select each cell, 

press F2, and then press ENTER. 

Tip: For a time that is based on the 12-hour clock, type a space, and then type a or p 
after the time; for example, 9:00 p. Otherwise, Excel enters the time as AM.   
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To edit the cell contents, do any one of the following:  

 To delete characters, click where you want to delete them, and then press BACKSPACE, or 
select them, and then press DELETE.  

 To insert characters, click where you want to insert them, and then type the new 
characters.  

 To replace specific characters, select them, and then type the new characters.  
 To turn on Overtype mode so that existing characters are replaced by new characters while 

you type, press INSERT.  
 To start a new line of text at a specific point in a cell, click where you want to break the 

line, and then press ALT+ENTER. 
 To enter your changes, press ENTER.  

 

 Notes 

 When you are in editing mode, many Ribbon commands will be inactive, and you will not be 
able to use them. 

 Overtype mode can be turned on or off only when you are in editing mode. When Overtype 
mode is turned on, the character to the right of the insertion point is highlighted in the 
formula bar, and it will be overwritten when you type. 

 Before you press ENTER, you can cancel any changes that you made by pressing ESC. After 

you press ENTER, you can cancel any changes that you made by clicking Undo on the 
Quick Access Toolbar. 

 A cell may display ##### when it contains data that has a number format and that is wider 
than the column width. To see all text, you must increase the width of the column.  

 

 

 

Enter the following data into a blank worksheet: 

 

 

Exercise 
 

Tip: To move the insertion point to the end of the cell contents, click the cell and press 
F2. 
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Then add: 

 Today’s date 
 Your name 
 Telephone number 
 Address 
 Widen column A so that the text for telephone number fits into the cell 
 Change the alignment of the date cell to left aligned 
 Change the formatting of the telephone number to text 
 Wrap the text of your address so that everything fits 

 

Your worksheet should look like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Saving Your Work 

Naming your Document 

When you create and save a new document, you have to take care that you: 

 Give the document an appropriate name 
 Save it in the correct folder 

 

 

 

Do not give the document silly names such as: Annatjie’s workbook or figures dated 7 September.   

Note: When naming a document in Excel, you must follow the same rules as when you 
name a document in the workplace.  
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In your workplace you will have certain filing rules that have to be followed, e.g. the client’s 
name, followed by the date or even the kind of letter you are creating:   

 BMW quote 7 Sep 
 Telkom account query 3 Feb 2009 
 XYZ Traders order 7 July 2009 

When you save your document, you must also follow the filing rules of your workplace.  If you have 
a filing cabinet at work, and correspondence for XYZ Trading is filed in a drawer, in a folder named 
XYZ trading, you must do the same on your computer.  You will have to open a folder called XYZ 
Trading in your My Documents folder and then save all the correspondence  and worksheets 
relating to this customer in that folder. 

Save your workbook 

Now you must Save your document to make sure that it is not lost when you exit out of Excel.  At 
the moment your document is called:  Book 1 as you can see in the title bar of your workbook. 

When you save a file, you can save it to  

 a folder on your hard disk drive, 
 a network location,  
 disk, 
 CD, 
 the desktop,  
 or another storage location.  

When you save a worksheet, you have to decide the location where 
the workbook has to be saved to.  For this you have to select a the 
target location in the Save in list.  

Otherwise, the saving process is the same, no matter what 
location you choose. 

If you are saving the file for the first time, you are asked to give it a 
name. 

 Go to the File tab and select Save  

OR 

 Click the Save icon on the Quick Access Toolbar. 

 

 

Complete the Save As dialogue box 

 Select the location  
 Give the workbook a name 
 Selet the type (formatting): usually Excel Workbook 
 Click Save 

 

 
Tip Keyboard shortcut: To save the file, press CTRL+S. 
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 Rules for naming workbooks 

Some rules when you are giving a workbook a name: The following characters cannot be used: / 
forward slash; \ backslash; > greater than; < less than; * asterisk; ? question mark; “ quotation 
mark; ¦ pipe symbol; ( colon or (;) semi-colon. 

 

 Closing A Workbook  

When you close a document, it clears your screen and enables you to start working on a new 
workbook. You have two options when closing a workbook: 

 Go to the File tab and click on Exit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

OR 

 Click on the bottom X in the right hand corner of your screen 

 



87 | P a g e  

 

 

 A dialogue box appears; asking you whether you want to save the changes you made to the 
document. You can choose Yes, No or Cancel.  

 

 

 If you choose Yes, the worksheet and the changes will be saved.  
 If you choose No, all the changes you made since the last time you saved this worksheet, 

will be ignored.  
 If you choose Cancel, you will exit the File, Close menu and return to the worksheet. 

 

 

 

 

 

 

 

 

 Formatting Numbers 

 

 

In your practice file enter the following amounts in cells D1 to D5:  

 D1: 28443;  
 D2: 31296;  
 D3: 8543;  
 D4: 12;  
 D5: 96.  

Then select these cells,  

 On the Home tab, click the Dialogue Box Launcher next to Number.  

Note: You don’t have to close one worksheet to open another, you can have more than 
one open worksheet at a time. 

Tip The X at the top will close the Excel program 

 

Exercise: Currency Format 
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 In the Category box, click Currency.  
 In the Symbol box, click the currency symbol that you want.  
 In the Decimal places box, enter the number of decimal places that you want to display.  
 In the Negative numbers box, select the display style for negative numbers.  

 

 

 

 

 

 

 

 
 In Cells E1 to E5, enter the following numbers: E1: 86236;   E2: 789654;   E3: 789;   E4: 86;   

E5: 98746.   

Tip: If you want to display a monetary value without a currency symbol, you can 
click None. 

 

Tip: Accounting formats line up the currency symbols and decimal points in a 
column 

 

Exercise: Accounting Format 
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 Once again, select Cells E1 to E5 
 On the Home tab, click the Dialogue Box Launcher next to Number.  

 

 In the Category box, click  Accounting.  
 In the Symbol box, click the currency symbol that you want.  
 In the Decimal places box, enter the number of decimal places that you want to display.  

 
 
 
 

 Change the decimal places option to two; click on OK. 
 All the R signs will be aligned underneath each other.   

 

 

 

 

 

Income is of course all your earnings: salary, commission, interest, maintenance, etc. Expenses are 
everything you have to pay: house rent, water and lights, telephone, school fees, transport, 
accounts, etc. 

Entering Formulas Into Cells 

 

 

 

A formula starts with an equal sign (=). 

 

 

Excel uses the following arithmetic operators that you will find on your numeric keyboard on the 
right hand side of the keyboard: 

 To Add use the  + (plus)  
 To Subtract use the  - (minus) 
 To Multiply use the  * (asterisk) 
 To Divide use the  / (forward slash) 

 
 
 
 

Note: The Negative numbers box is not available for the Accounting number 
format. 

 

Tip: If you want to display a monetary value without a currency symbol, you can 
click None. 

Tip: Put simply, a budget is a statement of your income and expenses, showing 
you how much money you have left once you have paid all your debts. 

 

Tip: Formulas are equations that perform calculations on values in your 
worksheet. 

 

Note:  You ALWAYS begin with a = in the cell where you want the answer! 
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 Click on a new sheet  in your Practice workbook. 
 In cell A1 type 250; in cell A2 type 320; in cell A3 type 125. 
 Start your calculation (your sum) by entering an = in cell A4 
 Click cell A1 and press + .See how the formula shows in cell A4 
 Click cell A2 and press+ .See how the formula shows in cell A4 as well as the Formula Bar 
 Click cell A3 and press Enter  - DO NOT PRESS + IN  CELL A3!!! Press Enter!!! 
 The answer will display in cell A4. 
 If you press + and then Enter in cell A3, an error message will display. You can click on Yes 

and Excel will make the corrections as proposed, or you can click No and make the 
corrections yourself. 

 

 

 

 Error Messages 

When you are adding in Excel, it is similar to adding on a calculator. You will type + in all the cells 
except the last one, where you press enter. Excel will automatically calculate and display your 
answer in the cell nominated by you, where you typed the =. 

If a formula cannot properly evaluate a result, Microsoft Excel will display an error value. Each 
error type has different causes, and different solutions. Error messages display in two ways: via the 
Office Assistant as in the example above and then as a message in a cell. 

##### Occurs when a column is not wide enough, or a negative date or time is used. 
Enlarge the column 

#VALUE! Occurs when the wrong type of argument or operand is used. There is something 
wrong with your formula, check the formula again. Also check that you used the 
correct cell formatting. 

#NAME? Occurs when Microsoft Excel doesn't recognize text in a formula. Usually this 
happens when you used a label in a formula, without labels being allowed. This is 
covered later in the manual. 

#REF! Occurs when a cell reference is not valid 

This lesson is important, because if you do not do the calculations in the right sequence, Excel will 
not be able to display the answer. 

Exercise: error messages 
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 Add A Column Using The Autosum Button:  

To do this task, use AutoSum. 

 

 Click a cell below the column of numbers or to the right of the row of numbers.  

 On the Home tab, in the Editing group, click AutoSum , and then press ENTER.  
 Excel will add the total of the column automatically.  Columns can only be added from the 

top to the bottom and rows from the left to the right 

 

 

 
 
 
 

 Enter the following amounts in column C: 
  C1:1230; C2: 4387; C3:2598; C4: 1121; C5: 7683; C6: 5576 
 Add the numbers using Autosum 

 

 Adding Using The SUM Function  

The SUM function is used to add noncontiguous numbers (numbers that do not follow each other).  

Exercise: use Autosum 
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Insert the following information in a new worksheet: 

A B 

Salesperson Invoice 

Buchanan 15,000 

Buchanan 9,000 

Suyama 8,000 

Suyama 20,000 

Buchanan 5,000 

Dodsworth 22,500 

 

 In the following blank cell, enter the following formula: =SUM(B2:B3, B5) Adds two invoices 
from Buchanan, and one from Suyama (44,000) 

 In the following blank cell, enter the following formula: =SUM(B2,B5,B7) Adds individual 
invoices from Buchanan, Suyama, and Dodsworth (57,500) 

 The SUM function can include up to 30 cell or range references 

You can also access the SUM function from the Insert function on the formula bar: 

 

 

 

Exercise: SUM function 
 

Note: You can also use the Sum Function to do calculations in rows rather than in 
columns. 
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 Subtracting 

The procedure to subtract is the same as to add: click the cell where you want the answer and 
then process the calculation. 

Remember, to subtract use the - (minus) on the numeric keyboard. 

=SUM(A2:A4) Adds all numbers in the list, including negative numbers 

 

 

 

 

 

 

 

In any two cells, type the following: 

15000 

-9000 

Use the SUM function to subtract 9000 from 15000: 

 

Exercise: subtraction 
 

Tip: Adding a negative number is the same as subtracting. 

 



94 | P a g e  

 

 

 Multiplication 

Multiply numbers in a cell 

 To do this task, use the * (asterisk) arithmetic operator.  
 If you type the following formula in a cell: =5*10 
 The cell displays the following result: 50 

 

 Division 

To divide, use the / (forward slash) on the numeric keyboard. 

 

 

 

 Enter the following amounts: cell A20: 8585; cell B20: 123. 
 Click on cell C20, enter = . 
 Click cell A7 and enter /, click cell B7 and press enter. 
 The answer will be displayed in cell C20 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise: multiply 
 

Formative Assessments 2 
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SECTION 3: END USER COMPUTING 

 

Specific Outcome 3 

Apply basic end user computing: 

 

Assessment Criteria 

 Relevant transport information is accessed via computer 
 Data is processed using word processor and spread sheet 
 Electronic mail is used 

 

3.1 Electronic mail  
With the aid of e-mail, written communication can be electronically sent around the word in real 
time (immediately). 

Electronic mail should be treated as normal mail and the writer should not compromise on the 
standard of content, layout, etc. 

When using e-mail, special care should be taken to secure information and protect the computer 
from access from outside. (hacking) 

 

 How E-Mail Works 

Sending and receiving e-mail is similar to sending and receiving mail via the 
Post Office.  

When You Want To Send Mail, You Need The Following: 

 A letter that you have written (or typed)  
 An envelope on which you have written the person’s 

address 
 A stamp must be fixed to the envelope and then 
 You take it to the Post Office to mail it in the red 

mailbox.  

Similarly, If You Want To Send An E-Mail, You Need: 

 To be connected to the Internet, with the required e-mail software, in this case Outlook 
 the e-mail address of the person you want to send e-mail to - the recipient 
 A mailbox where you can mail outgoing messages: the Outbox folder in Outlook. Once you 

have created an e-mail, it is stored in the Outbox until you go online 
again, then it is sent to the recipient.  

The advantage of e-mail is that, once the message has been sent, you still have 
a record of it in the Sent Items folder of Outlook 

If You Want To Receive Mail Via The Post Office, You Need: 

 A Post box 
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 A postal address 
 To collect mail regularly 
 To Receive E-Mails You Need: 
 To be connected to the Internet, with the required e-mail software, in this case Outlook 
 An e-mail address 
 A postal box in which to receive e-mails: the Inbox folder in Outlook is where all your 

incoming mail will be stored. 
 

 What Does An e-Mail Address Look Like? 

narina@photography.co.za 

An e-mail address consists of four parts… 

 Your name - narina 
 The @ sign that separates your name from the name of your ISP 
 The name of your ISP - photography 
 The domain - .co.za. The domain of course tells us it is a company in South Africa 

 

 Network Etiquette 

Content 

If you are sending emails from your work email address you should be careful of what you include 
in the e-mail.  It is easy to track the origin of an e-mail, so if you put vulgar, explicit or 
discriminatory content in an email, you could be caught and prosecuted.  Your system 
administrator can penalise you by taking away your e-mail and Internet privileges.   

Furthermore, if you send an e-mail from work, you could embarrass your employers, that is why 
your system administrator always monitors e-mails. 

Work related content that you send in an email should be typed in the same format as a normal 
business letter.  It creates a professional appearance. 

Here, we'll discuss some business writing rules and tips for practicing e-mail etiquette.  

People are busy, so:  

 Use the subject line. You might be tempted to bypass this part of the e-mail, but just 
remember: everyone is in a hurry, including the recipient of your e-mail. That person will 
appreciate the clue the subject line provides as to the message content. It helps them 
prioritize and organize.  

 Be brief and concise. No matter how clever and entertaining a writer you might be, your 
message recipients will appreciate brevity and clarity. Save the puns and witty turns of 
phrase for after birthday cards and toasts. State the message quickly followed by clear 
requests or instructions for any action needed by the recipient.  

 Keep it personal. Routinely copying others on e-mails clogs mailboxes and can lead to the 
main recipient wondering why you're doing so. Unless you have a specific reason for copying 
someone, keep the conversation between sender and recipient.  

 Reply quickly. Don't let e-mails sit around in your queue unanswered. Get back to the 
sender, even if it's to say you need more time to respond.  

People are sensitive, so: 

 Don't over-punctuate. Adding multiple punctuation marks, such as ???? or !!!! after a 
sentence makes it seem as though you are shouting or frustrated with the recipient. Use 
normal punctuation rules.  
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 Don't use all capitals. Using all caps MAKES IT SEEM LIKE YOU'RE SHOUTING. Shouting is 
rude. Use normal capitalization rules. If you need to emphasize something, write "I'd like to 
emphasize…"  

 Read it, out loud, before you send it. While you may think you're writing exactly what you 
mean, it pays to read some e-mails out loud to yourself, putting yourself in the recipient's 
shoes, before hitting that "send" button. Once it's in writing, it's hard to take back. Also, 
never forget that the recipient has both a printer and "forward" button. Never write 
something you wouldn't want to have circulated throughout the company or even beyond.  

 Don't write when you're angry. Perhaps one of the most common etiquette rules to break 
is firing off an e-mail to someone when you're angry, either at them or a situation. See 
"Read it out loud" above. You can't take it back once you "flame" someone, and it can come 
back to haunt you.  

Not everyone is as hip as you are, so: 

 Keep the symbols to a minimum. Using "smiles" is a trendy way to communicate mood and 
meaning. But do you know the difference between a sarcastic smile and a mischievous one? 
And even if you're sure you do, can you be sure your recipient does? It's easy to see the 
potential to unintentionally offend someone using these symbols. Avoid using them.  

 Minimize abbreviated phrases. Using abbreviations such as IMHO (in my humble opinion). 
FWIW (for what it's worth) and ROTFL (rolling on the floor laughing) can frustrate and 
confuse the recipient.  

E-mail is like as a business letter. Ignoring basic rules can show disrespect for the recipient. Don't 
let informality spoil the recipient's opinion of you.  

 

Privacy 

There are a couple of things that influences privacy on a network.  Most networks are not very 
private if it’s in an open office.  There are some office environments where passwords are not 
allowed. If you are allowed a password on your computer, your mails should be safe and private, 
although the company can give the network administrator permission to access your emails if they 
suspect you are doing or sending something you shouldn’t be.  

 

Confidentiality 

Some emails contain a confidentiality disclaimer.  If you find a mail like this, it is best to keep the 
contents of the mail you received confidential.  The disclaimer can be found at the bottom of the 
email.  You will find that disclaimers are most commonly found on emails from corporate 
companies. 

Of course, just as you would like your e-mails to be confidential, so do your colleagues want their 
e-mails to be confidential.  Respect other people’s privacy and they might just respect yours. 

 

 Start Outlook 

Once Outlook has been installed on your computer you can start the application clicking 
the Outlook icon. 
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OR 

On the Taskbar, click the Start button then select the Programs menu item. 

 The Programs submenu is displayed. 
 Click the Microsoft Office program item 
 Click the Microsoft Outlook program item 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The Outlook Application Window 

The layout of the Outlook application window is very similar to other Office applications. It has a 
Title and Menu bar, several toolbars and a Status bar. 

The main part of the window is divided into several frames (or panes). The pane(s) on the left are 
used to navigate the window and is called the Navigation Pane 

The rest of the screen (the Information Viewer) shows the component selected. 

Your Outlook screen may look different to the one shown on the next page with 
more or fewer panels and toolbars.  
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 The Title Bar 

 

The Title bar shows you which application (software program)you are running and it also shows you 
the name of the MS Outlook component you have open (Inbox).  

On the left-hand side of the Title bar is the Program icon. If you click this a menu of commands to 
control the Outlook window is displayed.  

You can also use the Minimise, Maximise /Restore and Close buttons on the right-hand side of the 
Title bar to control the window. 

 

 

 

 

 

Title bar Program Icon Ribbons 

Groups 

Folder 
list 

Information 
Viewer 

Preview pane 

Calendar 

Task List 
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 The Ribbons 

 

First introduced in Microsoft Office Outlook 2007, the ribbon is part of the Microsoft Office Fluent 
user interface. It is designed to help you quickly find the commands that you need to complete a 
task. Commands are organised in logical groups that are collected together under tabs. In Outlook 
2010, the ribbon has replaced the former menus in the main Outlook window. In addition, the 
ribbon can be customized to include custom tabs that you can personalize to better match your 
work style. 

The ribbons include: File, Home, Send/Receive, Folder and View. The groups under each ribbon 
contain the commands you will use to access the features of Outlook, in other words to give 
Outlook the commands to do what you want it to do: send the completed e-mail, print the e-mail, 
etc. 

 

 Toolbars 

Toolbars used to contain icon buttons that are shortcuts to selecting the command from a menu. 
These are now integrated and included under the ribbons.   

The example below is the Home ribbon.   

 

On the Home ribbon you will find different groups containing some of the buttons that used to be 
available on the toolbars in previous versions of Outlook.  Some of these groups include: New, 
Delete, Respond, Quick Steps, Move, Tags, Find and Send/receive. 

To move between ribbons, simply click on the ribbon name and the ribbon will open with other 
groups and options. 

 

 ScreenTip 

When you point to a button on in a group , a ScreenTip will appear.  The ScreenTip describes what 
the button does. 
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 The Status Bar 

The Status bar displays relevant information including the number of items and if they have been 
read as well as the progress when send/receiving mails. 

 

 

 Scroll Bars 

Sometimes the information on the screen is larger than area where 
it is displayed, such as a message.  When this happens you cannot 
see the entire message. 

Scroll bars help you to move around quickly so that you can read the 
message. 

You can scroll around by clicking the scroll arrows at the top or 
bottom end of the scroll bar or by dragging the scroll button in the 
scroll bar. 

 

 

 

 

 

 

 

 

 

 Menus/Ribbons 

The commands contained in the Ribbons are grouped 
according to function.  For example, in the Send/Receive 
ribbon, you will find groups related to sending and receiving 
emails. 

When you click on a Ribbon, such as Home, you activate the 
ribbon so it is displayed.  In this ribbon you will find groups of 
commands that pertain to the menu heading. 

You can use the mouse or the keyboard to select a command 
from a ribbon or groups. 

When a command appears faded out, we call it "greyed out".  
This means that the function cannot be used right now, you 
first have to do something else that will activate this function.  

When commands have an arrow beside them, it means that 
there is a submenu which contains a group of commands that 
relate to the main command.  For example, if you click on 
New Items, the submenu will contain commands that relate to 
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opening new items in Outlook. 

Point to or click on the submenu to select the next command or next submenu. 

Select A Ribbon Using The Mouse 

 Click on the ribbon you want to select. 
 Browse through the groups for the command you are looking for 
 Click once on the command to select it. 

 

 The Inbox Information Viewer 

This part of the Outlook screen will change according to the Outlook component you are using.  For 
example, the windows of the Inbox and Task components look different. 

You can make the left or right window panes larger or smaller, by clicking-and-dragging on the split 

bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The Navigation Pane and Folder List 

The Navigation Pane shows the name of the folder displayed in the Information Viewer.  

By clicking the arrow on the Navigation Pane, you can view a list of all the components and 
folders available in Outlook. This list resembles the Explorer pane in Windows. You can use it to 
open different components in the Information Viewer.  If the Navigation Pane is not open, it will 
appear minimised on the left of the screen.  

 

Scroll Bar 

Preview Pane Split Bar 

Folder List 

Message 
items 
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 Navigate in the Folder List 

 Click the arrow on the Navigation Pane to reveal the Folder List 
 Click the arrow once more to minimise it again. 
 Click an item in the folder list to open It 
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 Group Buttons 

Group buttons can be found at the bottom left of the screen.  These buttons are short cuts put 
here for ease of access to the different groups of ____ available in Outlook. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Exit Outlook 

If you minimise Outlook, it will remain open on the Taskbar while you are working in other 
software applications.  When you want to work in Outlook, click on the Outlook button on the 
Taskbar and the Outlook window will be displayed. 

When you want to shut down the PC, you have to exit Outlook first. 

There is more than one way to quit Outlook.  When you become a more experienced user, you will 
choose the method that works best for you. 

 

 Close Outlook 

 Click the File menu, then click Exit   
 OR 
 Click the Close button at the top right-hand corner of the Outlook window.  OR 
 Exit Outlook by double-clicking on the Program Icon in the top left hand corner of the 

Outlook window.  
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 Open Outlook 
 Close Outlook 

 

 Create A New E-Mail Message 

In order to send an email, you have to create the message in Outlook.  Once you have created a 
message, you must ensure that  

 you have addressed the message to someone,  
 you have given the message a subject 
 you have done a spell check 
 included all the necessary attachments 

before you actually send the message. 

 On the Home ribbon or from the New group, select the New Email button  
 

 

 

 

 

 

The mail item also appears on the Taskbar, so that you can switch between it and 
other Windows programs.  It shows on the Taskbar as Untitled Message. 

 

Exercise 
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 Enter Data Into The Mail Window 

To… 

Enter the e-mail address of the recipient in the To… box.  You can enter the names of more than 
one recipient in the To… box, as long as you separate the names with a semicolon(;), for example:  

narina@photography.co.za;albert@hotmail.co.za;yourname@timdutoit.co.za 

Cc… 

To enter an e-mail address in the Cc… box, follow the same procedure as above. Cc stands for 
Carbon Copy.  CC means that the e-mail is sent to that recipient for information only, the recipient 
does not have to respond or reply to the message. 

Bcc… 

Bcc stands for Blind Carbon Copy. When you enter a recipient’s address in the Bcc… box,  the 
recipients in the To… and Cc… boxes will not see the names of the recipients in the Bcc… box - 
that is why it’s called Blind Carbon Copy.  You will use the Bcc… box when you do not want the 
recipients in the To… and Cc… boxes to see that you are sending the message to a specific 
recipient. 

If the Bcc… box is not displayed, click the down arrow to the right of the Options... button and 
select Bcc. 

You can use either the Cc… or Bcc… boxes without using the To…box, as long as there is at least 
one recipient in one of the three boxes the e-mail can be sent. 

 

 Enter a Subject Heading 

Once you start sending and receiving e-mails, you will find that a lot of correspondence and 
communication is conducted this way.  It is possible that you will send and receive up to 300 e-
mails daily.  You will therefore appreciate it when people who send you e-mails give an 
appropriate subject heading, as the e-mail will be listed in your Inbox under the subject heading. 

Giving the mail a subject heading such as: Thabo’s mail will be silly.  When you write or type a 
document at work for a client or a superior, you always include a subject heading that gives details 
about the letter.  The same principle will apply to an e-mail subject heading. 

If the mail is about a weekly or monthly meeting, for example, include the full details of the 
meeting and the purpose of the e-mail, which could be the agenda or minutes of the meeting:  

Agenda for weekly meeting to be held on 25 Jan 06 

OR 

Minutes of meeting held 15 Jan 06 

If you only state minutes of meeting and the meeting is held every week, you will end up with 
about 50 e-mails with the same subject, which will make your life and the lives of the recipients 
very difficult when you want to find the minutes of a particular meeting. 

 

Think carefully about the subject heading and make sure that it makes sense, conforms to the 
protocol as prescribed by your organisation and, above all, ensure that it will be easy to find this 
particular e-mail again. 

 Tab  to or click in the Subject: box 

mailto:narina@photography.co.za;albert@hotmail.co.za;yourname@timdutoit.co.za
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 Type a subject heading for the message 

 

Body of the message 

Tab  to or click in the main box, where you will enter the message.   

Remember that an e-mail is usually an electronic form of a letter.  Follow the same format as If 
you are typing a letter.  If it is to a friend, it can be informal, if it is to a manager, it has to be 
more formal. 

 

 Insert A File Attachment 

At times, you will want to add an attachment to your e-mail 

 When you have typed a report, an agenda or minutes of a meeting in Word and you want to 
attach it to the mail 

 Or you want to include a picture 
 Or attach an e-mail to your mail 
 Or an Excel spreadsheet containing statistics, etc. 

It is possible to include more than one data file with your email message. Any type of file can be 
attached to a message, including documents, spreadsheets, graphics and so on.  Be careful of 
attaching too many data files to your e-mail, as it can make the mail bulky and slow to send and 
deliver to the recipients.  Just as smaller packages are easier to fit into your postal box at the Post 
Office, smaller e-mails are quicker and easier to send. 

You will also have to take the following into consideration when using file attachments: 

 Most, but not all, email systems can receive file attachments. 
 The recipient can only open and edit the attachment if they have the correct software - 

they cannot open the attachment in their email editor. 
 Large file attachments can be very slow to send and receive. Just like in your mailbox at the 

Post Office where it is easier to receive more than one smaller package than one large 
package, your mailbox (and the recipient’s mailbox) can handle smaller attachments with 
more ease. This means that at times you will send more than one e-mail to the same person, 
each one with one attachment, rather than one e-mail with many attachments. 

 Some email systems will reject messages if they exceed a certain size (often 1 MB). 
 File attachments can contain computer viruses 

 

 

 Attach A File To A Message 

 On the Message ribbon, click the Attach File button in the Include group, OR  on 
the Insert ribbon, click the Attach file button in the Include group.   

 
 The Insert dialogue box will be displayed.  Ensure that the Files of type text box is 

set to All Files.  This way you will see all the files that are available. 
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 Browse to select the file you want to insert and then click the Insert button in the dialogue 
box. You will usually find the file that you want to attach in the Documents folder. 

 You will see the file attachment in the Attach... box underneath the Subject: box. 
 If you attached the incorrect file and want to delete the attachment, click the attachment 

icon in the Attach... box and press Delete  on your keyboard. 

 To attach more files, follow the same procedure for each file. 
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 Send A Message 

 To send your message once you are done, simply click on the Send button next to the 
address and subject fields on the message.  

 

 

 

 

 

 

 

 

 

 

 

 If you have a dial up connection and you have to connect to the Internet before you can 
send messages, your message will be posted to the Outbox folder for sending when you go 
on line. 

 If you are on line all the time, the message will be sent directly and will appear in the Sent 
Items Folder. 

 To ensure that the e-mail has been sent, click on the Sent Items folder.  Check that your 
message appears in the folder.  If the message is not in this folder, check the Outbox folder.  
If you message still appears in the Outbox folder, it has not been sent.  Open the message 
and click on the Send button.  Once again, check that your message has been sent. 

 

 Internet 

Information on the internet is accessible by computer, using software and a modem.  The user 
accesses a website via his computer and immediately has access to all information on that site. 
(providing it is a free site – you need to pay subscription to access certain sites.) 

The internet is a source of news, government issues, publications, advertising, etc…there is 
literally no end to the information available on the internet, as additional information is added 
continuously. 

 

3.2 Obtaining information from computers 
In the transport industry, management needs information about vehicles, drivers, scheduling, 
routing, maintenance, legislation, finances, etc. to enable them to make the right decisions to 
successfully conduct business. 

Information needs to be accessible to those who require it to conduct their day-to-day activities.  
For these people it is essential to be able to access the information. 

In order for them to access the information, they will need computers, network, internet, as well 
as the necessary training to operate the software applications. 
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 Types of reports 

 In a typical transport operation various reports are used to communicate information.  These 
reports include: 

Vehicle reports – to monitor the state of vehicles.  

 Service reports – was the vehicle serviced according to schedule? 
 Fuel & oil reports – fuel and oil consumption is monitored. 
 Accident & claim reports – to accommodate insurance claims (if applicable). 
 Financial reports – e.g. profit & loss statements, etc. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formative Assessments 3 
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SECTION 4: GATHER OPERATIONS INFORMATION 

 

Specific Outcome 4 

Gather and understand operations information. 

 

Assessment Criteria 

 Standard operating procedure involved is explained 
 Technical skills are displayed 
 Variances are explained and questioned on the spot 

 

4.1 Operating Procedures  
A standard operating procedure is 

 a set of instructions 
 detailing standardised procedures  
 for completing specific tasks 

The standard operating procedures of your organisation will give details of how each job should be 
done, what resources should be used to do the work, how long the work should take to complete 
and how the completed job will be measured in order to find out if it was done correctly. 

 

a. Company policies and procedures 

Everything that takes place has to happen according to the organisation’s standard operating procedures: 

 How to work out routes and compile loads 
 What to do when problems occur 
 What documentation is needed for deliveries 
 The dress code and code of conduct of the drivers 
 The use and maintenance of vehicles  
 Reports that have to be done 

 

b. Procedures In Freight Transport 

Companies always have policies and procedures in place, be it a manufacturing concern, a 
wholesaler, a road transport company or a bus transport company. 

The policies and procedures are in place to ensure that employees know what is expected of them, 
to give them guidelines on how to do their work, to minimise errors and, of course, to improve 
productivity. 

In road transport, you will find company policies and procedures for routing and scheduling of 
vehicles, as well as control systems and reporting systems. 

The distribution function of transport would include the following activities: 
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 Compiling the loads 
 Routing: planning the route(s) 
 Scheduling: allocating vehicles and drivers to loads and routes 
 Dispatching 
 Liaison, monitor and control the delivery 
 De-briefing 
 General operating rules and procedures 

 

 Compiling Loads 

In order to group loads together, you have to know: 

 Which orders or loads must be processed and when they will be available for delivery   
 Where the goods have to go to: all the destination addresses by the area of delivery. 

Only then can you accurately and effectively compile a load: how many vehicles of which sizes will 
you use to transport the freight for each route. 

 Routing 

Routing and compiling loads go hand-in-hand, since you would compile the loads 
according to the route the vehicle will travel. 

 When the freight is loaded into the vehicle, the last deliveries are loaded 
first, so that they can be unloaded last.  This would normally be the 
destination at the furthest point of the route, unless your company starts 
from the furthest point and works to the closest point. 

 You will have to record which loads for which customers are in which 
vehicles and on which routes. 

 Your routing system must include all the vehicles you are using, all the loads that have to be 
delivered, including goods that are being redelivered, any additional instructions pertaining 
to the loads and any specific guidelines to find the correct delivery point. 

 You must also make sure that your routing minimises the distance to deliver each load. 
 

 Load By Despatch 

Once you have compiled your loads and done the routing, the driver must check and verify the 
loads, the routes and the delivery addresses. 

 

 Allocate Vehicles And Drivers 

The load has been compiled, the route has been worked out, the 
driver has checked the load.  Now the name of the driver and the 
registration number of the vehicle must be recorded in the driver 
trip sheet.  The driver trip sheet is then attached to the delivery 
documentation.  This way, the driver gets the driver trip sheet 
when he gets the load. 

The person who schedules the loads and works out the routes must 
know  

 the customers,  
 the products,  
 the delivery areas,  
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 the vehicles and  
 the drivers 

in order to make sure that the most cost-effective and efficient method of delivery is taking place. 

 

 Dispatch 

All transport companies should have a formal procedure according to which 
the dispatching of goods is done.  The following steps should be included: 

 Check the fuel of the vehicles: this can be done by the driver 
 Once a day the vehicle should undergo a daily check: this can be done 

by the driver, under the supervision of the supervisor 
 All the documents that relate to the load must be in place and 

correct: one person compiles the documents and checks that they are 
correct and the driver also checks the documents against the load 

 The driver report and an accident report must also be in the vehicle 
 A delivery or collection instruction sheet must be available and the driver and crew must 

confirm that they understand what is required of them; the specific routing instructions 
must be understood and any special reporting instructions must be understood 

 Tachographs must be in place (or OBC must be in order) 
 The crew must be properly dressed 
 If classified or dangerous goods are being transported, the required additional security 

checks must be completed by the driver 

The above procedures are the responsibility of: 

 The person responsible for scheduling and routing, 
 The supervisor of the section 
 The driver and even the crew of the vehicle. 

This is a team effort and each member of the team should take responsibility for the entire 
procedure or certain parts of the procedure. 

 

 Monitor And Control, Liaise 

There should be a policy in place to ensure that drivers and crew are being monitored and 
everyone should be aware of the policy.  The manager, supervisor or customer liaison officer 
should pay regular, unscheduled visits to customers to ensure that driver and crew are 
professional, on time and friendly.  In this way, the organisation can also ensure that company 
rules are not being broken by lifts for strangers, deviations from the route, unscheduled stops, etc.  

At the same time customer satisfaction with the product, delivery and general service levels of the 
organisation can also be controlled. 

 

 Debriefing 

When the vehicles return after all the loads have been delivered, a debriefing should be held to 
ensure that: 

 All the drivers reports have been properly and correctly completed 
 OBC is downloaded or the tachograph charts are completed 
 All the documents pertaining to the load have been completed and handed in 
 Any returns must be checked, explained, signed and unloaded from the vehicle 
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 Any service problems must be reported 
 Instructions for the following period must be received and understood by all parties 

If the supervisor is not present when the vehicles return, the procedures should be followed 
immediately when the supervisor returns or as soon as possible after the end of the shift. 

Goods that have been returned must be dealt with immediately. 

 

 General Policies And Procedures 

In most organisations, the above policies and procedures will have been published in the 
operations manual.  All employees must make sure that they understand  exactly what is required 
of them.  

All the team members must, furthermore, ensure that: 

 The policies and procedures are followed at all times 
 That no vehicle leaves the premises without the following: 

 Proper instructions 
 Tachographs /OBC 
 A driver’s report form 
 And accident/incident report forms 
 The correct documentation 

Then, the movements of all vehicles must be controlled using the same procedures as they apply 
for the specific loads and for all duties. 

The overall vehicle costs must be controlled by analysing every kilometre that the vehicle travels 
and every hour of truck time must be recorded every day without fail. 

 

c. Flow of information 

To ensure efficient management of a transport operation it is essential that the flow of 
information be regulated and standardised.  Reporting should be understandable and according to 
company policy and procedures. 

Reporting must be done at the right level and in the appropriate format, using the appropriate 
medium of communication. 

If a bus breaks down along its route the driver will use his cell phone or two-way radio to 
communicate the information directly to the workshop supervisor who, in turn can react 
immediately to remedy the situation.  In this situation, a verbal report, directly to the workshop 
supervisor is called for to expedite the remedial action.  The verbal report will later be backed up 
by a written incident report for record keeping purposes. 

On the other hand the CEO of the company will submit his annual report to the board of directors 
and other stakeholders.  This report will be compiled over a period of time, involving other 
managers and role players.  It will also be in a very detailed format, reflecting accurate facts and 
figures. 
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4.2 Identify And Interpret Variances 
A variance report is a way for management to find out how the company is performing by 
comparing one set of figures to another. This usually means comparing a planned amount to an 
actual amount.  

Companies frequently use variance reports to analyse how close they've come to hitting forecasted 
targets or to see if they've met their budgetary goals.  

Examples in the transport industry: 

 Kilometres travelled per vehicle 
 Oil and petrol usage 
 Tire usage 
 Number of services per vehicle 
 Overtime hours worked 
 Errors in deliveries 
 Number of fines per driver 
 Absenteeism 
 Customer complaints 

From all the information that is constantly recorded a manager can now study this information and 
will immediately be able to identify any variances.  

A variance can be defined as that which is outside of the norm. 

If a vehicle normally uses 25lt of fuel / 100km and suddenly uses 40lt / 100km, there is a variance 
of 15lt / 100km.  A variance like this has a great cost implication and has to be investigated to find 
the cause of the variance.  Was the fuel stolen or was it consumed due to a faulty vehicle? 

A variance of 1 – 3lt / 100km would be seen as normal as such a variance could be due to the 
vehicle travelling on bad road surface, forcing the driver to use lower gears, resulting in higher 
revs and fuel consumption. 

When we wrote the report on the investigation into the use of cleaning materials in the washbay 
rising by 17,4%, this irregularity was identified because the variance of 17,4% is outside of the 
norm. 

It is interesting to note that a variance of 5 - 10% in fuel consumption may be tolerated whereas a 
variance of 5 - 10% in the gross profit of the company would implicate a more serious state of 
affairs.  The variance in fuel consumption may only constitute a minute portion of the variance in 
the gross profit. 

 

 

 

 
 

Formative Assessments 4 
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SECTION 5: INTERPRET OPERATIONS INFORMATION 

 

Specific Outcome 5 

Interpret basic operations information (variance).  

 

Assessment Criteria 

 Oneself is organised in the workplace (time and task allocation) 
 Work flow and processes are explained and applied 
 The meaning of variances is explained 

 

5.1 Business Processes 

a. Systems theory 

In the business world, a system consists of a number of interdependent parts that function as a 
whole and have a common purpose. 

 A business or organisation is seen as a united, purposeful system with interdependent parts, 
functions and departments.   

 The different parts, functions and departments of the business system are dependent on 
each other and are therefore mutually bound to each other.   

 The different parts of the business system are orderly arranged according to a plan.  

The different parts of a system are called subsystems.  It is very important to note that subsystems 
are dependent on each other and that all the subsystems make up the whole business system.  

The systems theory was formed in order to make it possible to understand the working of an 
entity, such as a business.  Of course, the business is a whole system.   When you look at a business 
and its place in the environment, the business becomes a subsystem. 

 

 Open and closed systems 

Open systems interact with their environment all the time and they also depend on the 
environment for their success and existence.  A business is an example of an open system.   

The business interacts with the outside environment on a daily basis –  

 This is where their raw products and goods come from,  
 Where finished products and services go,  
 Where their employees come from, 
 Where the business gets resources such as water and lights from 

A closed system does not interact with the environment and the environment has no influence on 
the system.  Closed systems are usually mechanical and they have predetermined activities that 
will be performed, irrespective of the environment.  A watch is an example of a closed system. 
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 Flow through a system 

Information, material and energy flow into the system, through the system and out of the system.  
This is true of all the subsystems in the business, the business system as a whole and the 
interaction between the business and the environment.  The basic elements of a system are called 
the inputs, processing and outputs of the system. 

The outputs of one system become the inputs of another system.  In that system, the inputs are 
processed and become outputs, which then become inputs of another system. 

 

 Feedback 

This is the key to controlling the system and subsystems.  Feedback is used during the input, 
processing and output of each subsystem to evaluate the functioning of the system – is it working 
the way it is supposed to? 

 

 

 

b. Inputs  

Inputs are what is needed to do the work. 

In manufacturing, inputs are raw materials that you start with to make something else.  For 
example, if you want to bake a cake you need flour, eggs, milk, effort and skill of a person baking 
the cake, and so on.  If you want to build a house you need sand, cement, bricks, and so on.   

When you are processing information, the gathering and capturing of raw data would be inputs.  If 
you are working on the payroll, inputs would be salary and wage levels, employee details, 
overtime hours worked, bonuses that have to be paid, etc. 

FEEDBACK 

INPUT

S 
OUTPUT

S 
PROCESS 

FEEDBACK 
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c. Processes 

Processes bring together all the inputs in such a way that it produces the desired product.  All the 
steps, processes, procedures and modifications to the raw materials to produce the products and 
services of the business come into play here.  Often businesses have unique processes that make 
their products special. In manufacturing, for example, all the inputs are brought together to make 
the parts.  In our examples above, the inputs are used in the process of building a house or baking 
a cake. 

 

d. Outputs 

The result of what is done in the process/production phase is called an output.   

The finished product, the finished house and the finished cake are all outputs. 

Outputs can be divided into tangible and intangible outputs:  

 Tangible outputs are things that you can see and touch, like a box of matches 

 Intangible outputs are services such as in hospitals, training, telecommunications 

 

e. Feedback 

No process is complete without feedback. After a business has sold a product or provided a service, 
it must get feedback.   

Examples of feedback include whether the customers buy or do not buy the product/service, 
financial figures, staff turnover, sales, and so on.  

In our examples, the comments about the house – does it look nice, are people eager to stay in the 
house, etc., in the case of the cake – do people eat it and tell you how good it tastes, how nice it 
looks, etc.  

 

f. Business systems and the business process 

As mentioned, any business or organisation is made up of subsystems.  All these subsystems have 
inputs, processes, outputs and feedback.  The output of one system becomes the input of another 
system. 

The purchasing department have to ensure that they purchase the correct raw materials for 
production department.  Their output is the raw material used by production.  The raw material 
becomes the input for production department, the process is manufacturing the product, their 
output is the finished product.  The finished product becomes the input for sales department who 
have to sell the product.  The process is the actual selling of the product to customers and the 
output is the sold product. 
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In this way, all the subsystems of the business are linked to each other. 
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Delivering products/services that meet customer requirements is NOT enough. For an organisation 
to sustain itself into the future, its 'recognition/reward' must not exceed the cost it’s incurred to 
deliver those products/services. 

 

Organisations are formed so that products and/or services can be provided to 
targeted customer communities. 

 

Performance = Effectiveness + Efficiency 
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Performance is a measure of an organisation’s ability to efficiently combine, convert or utilise 
input resources into effective output products/services in a financially viable manner. 

 

g. The work process value chain 

All organisations that provide products and/or services are made up of a variety of work processes. 

 

 

 

INPUTS 

People 

Material 

Equipment 

RESOURCES 
PRODUCTS / 

SERVICES 

OUTPUTS 
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In most work processes, people use equipment to convert input resources into an output product or 
service. These products/services are then 'delivered' to an internal customer. 

 

 

 

 

 

 

5.2 Workflow 
A workflow consists of a sequence of connected steps.  

It shows a sequence of operations, e.g. the work of one person, a group of persons, or an 
organisation of staff. 

The following examples illustrate the variety of workflows seen in various contexts: 

 In machine shops, particularly job shops and flow shops, the flow of a part through the 
various processing stations is a work flow. 

 Insurance claims processing is an example of an information-intensive, document-driven 
workflow. 

These work processes are linked together like a chain of internal suppliers and 
customers. 
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a. Workflow components 

To describe a workflow, flow diagrams that show the directed flows between processing steps can 
be used.  Components of a workflow are defined by 3 parameters: 

 Describing the inputs such as information, material and energy needed to complete the step  
 Describing the rules or process for transforming the product or service. This may be done by 

people, machines or a combination of the two.  
 Describing the outputs, such as the information, material and energy produced by the step 

and provided as input to the next BSU, team or section.  

The workflow components can only be linked together if the output of one set of components is 
equal to the input requirements of the following component.  In other words, the output of one 
component must comply with the quality, time and other requirements of the next step in the 
workflow. 

Mapping the logical progression of work will assist in improving productivity to a large degree.  To 
do this ensure the following: 

 Plant layout is correct 
 Correct sequence of operations  
 Right people to do the right job at the right time 
 Correct tools and machinery available 
 Sufficient materials available 
 Proper control is exercised 

Chart the sequence of phases and steps to reflect the intrinsic and 
architectural dependencies inherent in the work.  

An output of one step will be the input to another.  Some inputs may be sourced from outside the 
project.  These External Inputs (e.g., Standards, Project Initiation report of another project, etc.) 
must be identified.  The project products and external inputs will primarily determine the step 
dependencies.   

Define the dependencies, and dependency type, between the steps.  Steps within a phase are not 
necessarily finish-start, but may be in parallel or phased.  Phases may also run in parallel with one 
another.  Do not specify dependencies at the phase level. 

Workflow is organised to achieve minimal wastage and delay. 

Workflow is often shown graphically as a flowchart. 
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Following is an example of a very simple flow chart for the process of getting out of bed in the 
morning: 
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The following figure shows an example of a workflow for an expense report. The workflow includes 
elements that are assigned to specific users 

 

 

 

 

 Input 

Process 

Output 



126 | P a g e  

 

This example show a workflow for a student loan 

 

This example shows a workflow for a purchase order 

 

 

b. Warehousing 

We will discuss a typical workflow by discussing the warehousing aspect of handling freight. 

Warehousing is the part of the logistics system that stores products at the point-of-origin and 
between the point-of-origin and the point-of-consumption. The goods that are stored include raw 
materials, parts, goods-in-progress and finished products.  Warehousing also gives management 
information about the status, condition, quality and quantity of products that are available. 

Warehousing supports the time and place utility of  goods because goods are produced and held for 
later consumption. 

Warehousing plays an important role in a logistics system, as it creates the desired level of 
customer service at the lowest possible cost.  Warehousing is the link between the company and 
the customer.  
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Inventories must be warehoused for the following reasons: 

 To make transporting and producing as cost effective as possible 
 A warehouse allows an organisation to buy in bulk at reduced prices 
 A source of supply can be maintained 
 The warehouse supports the customer service policies of the organisation 
 The warehouse can assist the company to meet changing market conditions 
 The warehouse enables the organisation to minimise the time and space differences 

between the producers and the consumers 
 To provide total cost logistics at the least cost possible while maintaining customer service 

at the desired level 
 The warehouse supports the JIT programs of suppliers, vendors and customers 

 

c. Warehouse Activities 

 Movement 

Includes four handling activities: 

Receiving 

 physically unloading products from the transport carrier 
 updating the warehouse inventory records 
 inspecting for damage, verifying the merchandise count against orders and shipping records. 

 

Transfer activities 

Physically moving the product: 

 Into the warehouse for storage 
 To areas for specialised services such as consolidation of freight 
 To outbound shipment 

 

Order selection 

 Regrouping products in the assortments customers want 
 Making up packing slips 

 

Shipping 

 Physically moving assembled orders into carrier equipment 
 Adjust inventory records 
 Check the orders that have to be shipped 

 

 Storage 

Temporary 

This is storage that is necessary for basic inventory replenishment.  It is necessary to replenish 
inventory and depends on the design of the logistics system and variations in lead time and 
demand. 
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Semi-permanent 

This is storage of inventory that is held over and above the stock required for normal 
replenishment.  It includes safety stock that is held to cope with seasonal demands, stock 
purchased through special deals and stock held for special deals to the customer. 

 

 Information 

Information in any organisation is vital.  It must be: 

 Accurate: no sensible decisions can be made in an organisation if the information is 
incorrect.  

 Timely: outdated information has no value in an organisation 
 Occur at the same time as the movement and storage activities take place 

The importance of information in any business process cannot be stressed enough.  In a warehouse, 
management must have accurate and timely information to administer the warehouse. 

The information generated by warehouse activities includes: 

 Inventory levels: the stock levels of the various stock items 
 Through-put levels: the movement of stock in and out of the warehouse 
 Stock-keeping locations:  where the different stock items are kept 
 Inbound and outbound shipments:  goods received and despatched 
 Customer data 
 The utilisation of space in the warehouse: how is the space in the warehouse used 
 Personnel: who is doing what, who is on leave, who is off sick, who is on training, etc. 

 

 Materials management 

Materials handling is the movement of materials and components within a company. This includes 
the movement of raw materials, work-in-progress and finished goods within the warehouse. 

Every time an item moves or is handled, the organisation incurs costs without any value being 
added to the product.  The purpose of materials management should therefore be to move 
materials only when absolutely necessary. 

When handling materials, always ensure that the following is kept to a minimum: 

 the travel distance 
 bottlenecks 
 inventory levels: do not keep unnecessary stock 
 loss due to waste 
 loss due to mishandling 
 loss due to damage 
 loss due to pilferage 

 

 

 

 

In order to do this, you will have to analyse material flows carefully in order to keep 
costs to a minimum. 
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d. Warehouse Handling Equipment 

Warehouse handling equipment is classified according to the jobs they have to do: 

 Storage and order picking 
 Transportation and sorting 
 Shipping.  

The equipment will include manual as well as automated equipment. 

 

e. Storage and order picking 

Includes racks, shelves, drawers and equipment used by operators, such as forklifts.  A bin-shelving 
system is usually used for smaller parts and components where the items are held in a bin and 
hand-picked when used.  These bins are usually within the physical reach of workers and these 
systems are inexpensive when compared to other storage systems.  Unfortunately, there is always 
space left over in the bin, creating wasted space.  

Storage racks are considered standard components of a warehouse and are usually placed so that 
they can be accessed with forklifts and other materials handling equipment. 

 

 Manual systems 

when the stock turnover is either very low or very high, a manual storage system will  be able to 
do the job.  Manual systems also provide a great deal of flexibility in picking orders. 

 

 Automated systems 

The following equipment will typically be found in automated storage and retrieval systems: 

 Carousels 
 Case picking and item picking equipment 
 Conveyors 
 Robots 
 Scanning systems 

 

f. Transportation and sorting 

Transportation equipment moves materials between warehouse areas at the least cost and is the 
connecting link between major warehousing activities in the receiving, storage and shipping or 
despatch areas.  This equipment also integrates the operations at receiving and shipping.  

 

g. Shipping 

This involves invoices, preparing items that have to be despatched and loading shipments into the 
vehicle.  Shipping and receiving docks are important, since this is where goods are sent out or 
received and the docks must be able to accommodate the equipment that is used to receive and 
ship goods. 
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h. Materials handling equipment 

This is the movement of goods over short distances, into or out of in within the warehouse and 
does not involve transport carriers.  The goods are typically moved from the receiving area to the 
warehouse, where they are stored.  From the warehouse raw materials  are moved to the 
production line for the manufacturing process.  finished products are moved to the warehouse for 
storage. Once the goods have been sold, they are moved from the warehouse to the shipping bay, 
loaded onto vehicles and delivered to clients.  

These movements should be the maximum movement of goods, since moving goods from one shelf 
in the warehouse to another shelf in the warehouse adds cost to the goods without adding any 
value. 

The space in the warehouse should be used efficiently and stock items should not be misplaced.  

Equipment typically used in materials management include: 

 Airtube systems and Air curtains 
 Automated guided vehicles (AGV’s) 
 Automation and robotics systems 
 Conveyors and parcel sorting 
 Mono rails, cranes and hoists 
 Lift tables and other lifting equipment and tackle 
 Ladders, cartons and related products, marking equipment 
 Packing machinery and accessories 
 Pallet tables and pallets 
 Pulleys, ramps, slings, stackers 
 Trolleys, turntables and carousels 
 Vacuum lifting and weighing equipment 

 

i. Guidelines for materials handling systems design 

 Invest in handling equipment rather than stationary equipment 
 Design the system so that maximum continuous product flow is given when the materials 

handling process is in motion 
 Ensure that you standardise the equipment for handling and storage as much as possible 
 Always try to get the maximum use out of the handling equipment 
 When choosing the equipment, try to maximise the dead-weight to payload ratio 

 

j. Integrated Distribution Centre 

Today a warehouse is not simply a place where goods are stored, it is actually a flow-through 
distribution centre (the goods should flow through the warehouse) where value is added to the 
goods. 

An integrated distribution centre should move products quickly and efficiently in order to provide 
the link between the company’s demand and supply chains. 

As far as supplies are concerned, the distribution centre (DC) focuses on 

 Efficiently handling the goods 
 Managing inventory 
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 Product flow 
 Transportation 
 Delivery 

As far as demands are concerned, the DC must meet the specific requirements of the customer, as 
fast and efficiently as possible.  In the world today, the customer drives the development of 
distribution centres as their demands require that the supply chain must be streamlined.  

The integrated DC is the key to the flow of products from supplier to manufacturer, to the store in 
order that: 

 The right products  
 Are delivered at the right time 
 At the right cost 
 Here is an example of a multi-functional distribution centre: 

 

 

In a DC the products are not stored, they are moved.  Customers have increasing demands: 

 More frequent shipments 
 No more stock outs 
 Direct store deliveries 
 Customisation to make the products floor-ready 
 Bar coding of containers 
 Drop shipments 

 

This means that the DC must be able to: 

 Reduce inventory in sourcing, manufacturing, distribution and at the customer 
 Respond quickly to an environment that is constantly changing 
 Act as an extension of the manufacturing process by preparing products so that retailers can 

send the products directly to selling floors 
 Manage inventory, product movements and transportation across corporate boundaries 

where all the supply chain members are linked electronically in order to share information 
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 Provide instant and continuous feedback about order, inventory and production status 
 Move products faster and with more accuracy 

In order to comply with increased customer demands, managing the distribution centre means that 
the methods used must guide, pace, test and coordinate all the components of the DC.   

 

 

k. Layout Of Buildings 

Before planning the layout of a store with any degree of certainty, to provide a satisfactory base 
for efficient operations, it is necessary to determine the storage needs with great care. It can then 
be decided:  

 What best can be done in terms of grouping stocks?  What stock will be stored where in the 
warehouse? 

 What will be provided in the way of a building or site for each group of stock? 
 Exactly what type of service will the store provide? 
 What kind of supporting facilities are required for a particular store? 

If there is disjointed planning of the stores layouts, where each section does not form a part of the 
overall plan, the likely result will be: 

 Poor service. 
 Inadequate control. 
 Costly administration.  
 Unnecessary duplication of equipment and facilities. 
 Frequent emergency rearrangements in order to meet unforeseen circumstances. 

 

 Detailed planning of layouts 

When there is a clear picture of the overall requirements, it is then possible to commence planning 
the facilities with regard to obtaining the greatest possible efficiency. 

The layout of each location must be dictated by the particular requirements of the store areas. 
These requirements will be influenced by: 

 

 The nature of the functions being performed 

The determination of material needs. 

 The receipt and inspection of incoming materials and supplies. 
 The storage, safekeeping and issue of materials and supplies. 
 Centralised or decentralised storage of materials and supplies. 
 The recording and administration of stock. 

The handling and transportation of materials 

 The need for "work flow" to be considered in the particular location. 
 The working space required for each of the functions involved. 

The type of materials involved, or the mix of materials in the particular location 

 Raw materials 
 Piece parts 
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 Bought-out parts 
 Work-in-progress 
 Tools and patterns 
 Jigs and fixtures 
 Equipment and spares 
 General stores 
 Packaging materials 
 Finished products 

 

The nature of certain materials which will require special consideration 

 Valuable or attractive to pilferers.  
 Fast-moving or slow-moving. 
 Requiring special. means of storage, for example, liquids. 
 Bulky or awkwardly shaped. 
 Dangerous 
 Identical components which must be stored in two separate areas for different purposes, 

such as production supplies and supplies of spares. 

 

General functions 

 The gangways, corridors or free areas necessary for the travel of overhead cranes or the 
movement of other materials handling equipment. 

 Areas for the receipt or despatch of internal or external transport.  
 The need to assist administration and supervision to maintain efficient control. 
 The need for flexibility, so that facilities can be adjusted in order to meet changing 

circumstances. 

 

l. Flow Of Materials 

In planning the layout of stores, the flow of materials must be arranged in such a way that it 
involves no unnecessary movement of materials. Any unnecessary movement adds considerably to 
the cost of the material concerned. 

Ideally, it could be arranged for goods to arrive and flow from goods received to inspection, to 
storage, to issue point, to user department.  

In practice, however, there are many factors which must be taken into account in dealing with the 
material flow. Some of these factors are: 

 The design of the building used. 
 The size and weight of materials. 
 The type of materials. 
 The handling equipment which is available. 
 The methods of storage used, for example stocking, bins, pallets, and pallet racks. 
 The nature of the issues made. 
 Safety requirements. 
 Need for good access. 
 Security. 

It is an advantage, in many cases, to have materials stored in areas according to the frequency of 
use, so that fast moving items are placed together, less frequently used items placed together, 
and slow moving items also placed together. 
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The type of storage may also be a factor which must be considered, since items in bins must be 
located together, as must items in pallets and racks. 

The layout of the stores must assist the flow of materials, and often expensive and elaborate 
layouts are needed to maintain the flow of materials to flow production lines, where high volume 
issues are required. Overhead conveyors are quite often used, passing through the stores to the 
work stations on the production line.  

Automatic warehouses and stores based upon a random access method of  storage are possible 
when computers are used in stores. When goods are received, the information giving all of the 
details is fed into the computer.  

A key piece of information which is required is the size and the weight of the article, which is 
given by a code, which enables the computer to locate a suitable fixture and location to house the 
item. When issues are to be made, this location will be printed out on the issues voucher. The 
issue voucher will be sorted into "order packing sequence" thus enabling the employee to go round 
the stores, in correct sequence, to pick all those items without retracing his steps. 

It may well be that in a small organisation, all stores facilities must be provided within a single 
building, and if an efficient service is to be provided, all the above factors must be considered 
when planning the layout of that building. 

The larger the organisation one is dealing with, however, the more fragmented the stores facilities 
become. Also the activities of each store location becomes more specialised. Whilst this may 
simplify the layout of individual stores locations, it demands a more detailed consideration of the 
function or purpose of each. 

Some of the specialised applications which justify individual considerations are: 

 Centralised goods receiving. 
 Centralised storage. 
 Special storage facilities. 
 Supporting facilities to stores. 

 

5.3 Organise yourself at work 
Two important activities of a supervisor are planning and scheduling of the work that has to be 
done by the team or the section in order to meet to goals and objectives that have been set for 
the team or the section. 

A plan is a description of the logically necessary set of activities that have to completed in order to  
accomplish a specific goal.  

A plan, supported by a schedule, timelines for the completion of the tasks and resource allocation 
calculations, should give a complete picture of the process that has to be followed in order to 
achieve the goals and objectives of the team/section. 

 

a. Planning  

Planning is a management function whereby goals are defined and decisions are made about the 
tasks that have to be carried out to achieve the goals and the resources that should be used to 
achieve the goals. 
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During the planning process, the manager considers the goals and objectives that have to be 
achieved.  In order to achieve these goals and objectives, certain tasks have to be carried out by 
making use of resources.  The tasks have to be prioritised and allocated to employees who have to 
physically carry out these tasks. 

 

b. Purpose of a schedule  

A schedule is a list of tasks, showing the intended start and finish dates, the resources that will be 
used and sometimes even the costs involved for finishing the task.   

The purpose of a schedule of activities (tasks) is therefore to: 

 Specify the tasks (work) that must be carried out  

 Decide who will be responsible for carrying out the tasks – employees 

 Specify when the task should start and when it should finish 

 Find out if dependencies between tasks exist.  If so, the dependencies must be shown on the 
schedule. 

 Find out what resources will be available to complete the tasks and who will supply the 
resources 

 Determine what costs are involved. 

Without a schedule of activities chaos will be the result, as: 

 The people who have to do the work will not know what to do, how to do it, by when to do 
it and what resources they can use to do the work. 

 The manager will find it impossible to monitor progress of the work, how resources are used 
and when they will be available or whether activities are happening within budget.  

 Nobody will know which tasks are linked by dependencies and this will cause stoppages and 
delays. 

 

c. Steps to create a schedule 

To create a schedule, you have to follow certain steps:  

 Identify and list all the tasks 

For example, if your goal is “Paint the classroom,” your schedule activities might include  

 Calculate the amount of paint needed and purchase the paint 

 Prepare the walls by sanding the walls 

 Put the base coat on the walls 

 Once the base coat is dry, add the final coat 

You also have to take into account: 

 Weekly and monthly progress reports 

 meetings with management  

 Team meetings 
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 Prioritise the tasks in chronological order 

This is step 2 in the scheduling process, where you arrange the tasks in the order they have to be 
carried out.  In other words, you prioritise the tasks. 

When you water the garden, the logical order is to: 

1. get the hosepipe out of storage 
2. connect the hosepipe to the tap 
3. connect the sprayer to the hosepipe 
4. place the hosepipe where you want to water the garden 
5. open the tap 
6. after a period of time, move the hosepipe to a new location 

If you do not carry out the activities in this order, you could open the tap before your have 
connected the hosepipe or the sprayer 

 

 Note task dependencies  

A task dependency occurs when one task cannot start before another task has been completed.  
For example, you cannot make photo copies before the toner cartridge and paper have been 
loaded into the photo copier.  In this instance, you first have to make sure that the photo copier 
has toner and paper before you can make a photo copy – this is a task dependency. You cannot 
build a house before the foundation has been laid, you cannot lay tiles before the surface has been 
prepared, etc. 

 

 Estimate the time each task will take to complete 

Time is money and you need to know how long tasks will take to complete in order to make sure 
that you meet deadlines.  When you allocate a time to a task it also makes it possible for you to 
check when the task is taking longer to complete.  You can investigate the problem and find a 
solution – for example did a machine break down and you should request team members to work 
overtime, or should more people be allocated in order to finish the task on time.  

It is vitally important that tasks are completed on time.  In many industries, the business has to 
pay penalties when tasks are completed late.  Any task that is not completed in time costs the 
business money and this affects the profitability of the business, salary and wage increases and the 
growth of the business. 

Remember to add holidays, vacation time, meetings, etc. to the schedule 

 

 Assign resources to the tasks 

A resource is anything used to help people do their work and includes:  

 Human resources  

 Machinery and equipment 

 Tools and supplies 

 Facilities such as a boardroom, lecture room, etc. 

When you allocate resources to tasks, you can refer to technical experts and other team members 
to help you, if necessary.  Also check if resources have to be shared by more than one team or 
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employee.  If this is the case, it could mean that one team has to wait for a resource before they 
can start doing their work. 

Without the necessary resources, the team members will not be able to complete the tasks. 

 

 Decide who will carry out the tasks  

When you decide who will carry out a specific task, you will think about: who is available and who 
has the most knowledge and experience – in other words the best person for the job. 

 

d. Importance of scheduling tasks 

When you develop a task schedule, you make sure that everyone involves: 

 Knows who must do what 

 What resources (tools, machinery, equipment, etc.) they may use to finish the task 

 When the task should start 

 When the task should finish 

 Whether you are staying within the budget or not 

 

5.4 Task Lists 
So, the first step is to determine what has to be done to achieve the objectives.  A task list can be 
used effectively for this step.  A task list is a list of tasks that have to be completed, such as 
chores or steps toward completing a project. 

Before you draw up a task list, clarify the tasks: Rather establish upfront what is expected than 
discover that you have concentrated on peripheral aspects.  Questions that you could ask in this 
regard are: 

 What is the purpose of the task or activity? 
 What are the measures of success? 
 What is exceptional performance? 
 What are the priorities and deadlines? 
 What resources are available? 
 What costs are acceptable? 
 How does this relate to other people, action plans and programmes? 

 

a. To draw up a task list:  

 Work out what resources you will require: the quality and the type of resources. 
 Define each task’s objectives: what do you expect to accomplish with each task? 
 Determine performance measures: how should the task be done and how will you know if it 

has been done according to the performance measures? 

The next step is to develop an outline of the task list.    In order to do this, you have to break the 
tasks down even further: 

 Break each task down into sub-tasks and identify all the relevant activities.  Here you list 
the steps required to complete a task. 
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 Specify the duration or time that should be spent on each step 
 Specify the earliest time when a task should start in order for the task to be completed on 

time. 
 Specify the latest time a task should start in order for the task to be completed on time. 

 

b. Prioritise tasks 

Once the task list has been drawn up, the next step is to prioritise the tasks: what has to be done 
first.   

 Which tasks have to be completed before another task can start – the sequence in which 
tasks have to be completed.  For example, before you can make a cup of coffee you have to 
determine whether you have a cup, coffee, milk and sugar.  Then you have to switch the 
kettle on, for without boiling water you cannot make any coffee. 

 What specific activities are involved in each task?  How difficult will it be to complete?  Do 
you have employees capable of doing this or must you get the assistance of a contractor? 

 Identify the tasks most critical for the completion of each stage of the work or project 
 How long will it take to complete each task?  Establish the sequence of tasks that will best 

fit the time constraints 
 Number each task in order of priority 

Sometimes, when we are faced with a large piece of work or project it can seem overwhelming. 
Where do we make a start? Often, we make a start, but not at the beginning, and then leave key 
tasks until it is too late and we have a crisis on our hands. On one page we should break down the 
work into its individual tasks. Start with the major tasks and break them down into smaller tasks 
until everything that needs to be done has been identified. 

 

c. Procedures 

A procedure is a plan of action that indicates the method that must be followed to complete 
certain activities. 

A standard operating procedure is a set of instructions that tells the employee what to do, how to 
do it and what resources should be used to do the work.   

If your organisation has a standard operating procedure, consult this when you are allocating and 
prioritising tasks.  If not, make an effort to put together a standard operating procedure. 

 

d. Allocate the tasks 

Once the tasks have been prioritised, they have to be allocated to 
employees to carry out the tasks, in the order that they have been 
prioritised. 

This is usually done by means of a schedule or an action plan.  
Scheduling of tasks involves telling the supervisors or team leaders: 

 what to do or make 
 when to do it or make it  
 which staff should be used  
 and which equipment should be used to carry out these tasks 

Before we can schedule and delegate tasks, we have to know:  
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 What kind of knowledge or expertise is required for each task? 
 Who best suites the demands of the task?  In other words, who can do the work? 

Alongside each individual task we should write down an estimate of how long it will take to 
complete. Next we should decide on an appropriate deadline for each task. Also include the 
knowledge and skills required as well as who will be completing the task. 

Many tasks can be completed at the same time, while others may have to be performed one after 
the other. We should be realistic here and allow for delays. It might take us 10 minutes to obtain 
an item of information from a colleague, but it may take us a week to arrange a meeting with 
them. 

Once we have completed our scheduling, we can set a deadline for the completion of the work.  

When you assign tasks to other people, make sure that they know exactly: 

 What has to be done 
 How it should be done 
 When it should be done 
 Why it should be done 

 

e. Time management 

One of the functions of a manager is planning.  Top management does the strategic planning in an 
organisation.  These plans and objectives are divided into different tasks and delegated to senior 
management who then subdivides these tasks an allocate them to the appropriate department 
heads or front line managers. 

When the junior manager receives his tasks from senior management, he needs to do his own 
planning for the successful execution of these tasks, making optimum use of available resources, of 
which time is but one. 

The first step in time management is the setting of goals and objectives.  A goal determines where 
you want to be at a certain time in future.  Objectives would then be the activities to reach this 
goal.  

Goals can be divided into strategic or long term goals, tactical or medium term goals and 
operational or short term goals. 

In business, strategic planning is normally done by top management, who define strategic or long 
term goals in the business plan and allocate a number of years for the achievement of these goals.  
Strategic goals will also reflect the vision and mission statement of the organisation. 

Tactical or medium term goals are determined by senior management who allocate tasks to their 
respective sections or departments. 

Operational or short term goals are set by junior managers and determine the day to day 
operation of the particular section or department. 

The importance of goal setting cannot be stressed enough.  A ship at sea or an aircraft in the air 
travels from a certain place to another specific place at a specific time.  Likewise it is necessary 
for people working together in an organisation to know what is expected of them so that activities 
are planned and coordinated. 

Goals must be S-M-A-R-T. 

 S  pecific 
 M  easurable 
 A  chievable 
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 R  ealistic 
 T  ime related 

Everyone concerned must be informed about what the goals for that section or department are. 

The manager must now draw up a list of tasks for himself to ensure that he can see exactly what 
he needs to do. 

We are all human, and therefore are certain to fail in some respect at some time.  It is impossible 
to remember everything one sees or hears and to randomly recollect all facts pertaining to a 
specific event or subject at any given time.  That is the reason why we (the human race) invented 
symbols, cave drawings, eventually writing and, in modern times, innumerable ways and means of 
storing and distributing information.   

The task list presents itself as a very handy management tool to store information about what has 
to be done and when.  As said, we cannot remember everything.  By drawing up a task list, the 
manager can be aware of all activities that he needs to attend to during his work day, month or 
year. 

Likewise, he has to compose a task list for the team under his supervision.  This will inform all 
team members of their responsibilities towards completing the task successfully.  The team task 
list must be drawn up after consultation with team members, to get input from members, who 
might contribute ideas, not thought of earlier, and can also enlighten management on matters at 
ground level, which management don’t have first hand knowledge or experience of. 

When assigning tasks to a team, the manager must apply the same principles as when setting goals.  
In other words, tasks must also be :– 

S  pecific 

M  easurable 

A  chievable 

R  ealistic 

T  ime related 

 

By applying the above principles, the manager lets everyone know exactly what is expected of 
them and where they fit into the overall picture.  The steps and processes to be followed needs to 
be specified so as to eliminate any uncertainty. 

It is also very important to allocate time to all tasks, to set standards and to ensure that tasks are 
completed timeously, according to schedule.  All team members must know that if they fall behind 
schedule, the next link in the chain is going to start with a backlog, as result of the previous task 
not being completed on time.  This will impact negatively on everyone down the line. 

All information and documentation relating to the performance of a specific task must be recorded 
on the task list.  This will enable the manager to see where possible problem areas are and assist 
him to take the necessary remedial and/or corrective action to solve the problem. 

Any additional information gathered during the performance of the task, and which might be 
useful to increase effectiveness and efficiency, should also be recorded for future reference. 

From the above mentioned it is clear that having a task list for self and the team is important and 
a valuable management tool, but this tool is not worth anything if not utilised properly.  These 
lists must constantly be updated with any relevant information.  Yes, you must also record things 
that reflect negatively on own or team performance. 
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A plan of action needs to be formulated from the task list, taking into consideration that there 
might be deviations from the original plan.  There might also be additional tasks that get added 
along the way.  These new tasks must be incorporated into the action plan and tasks must be 
reprioritised, if necessary, to align action plan with time available and to ensure that all tasks are 
executed timeously. 

Once a task has been completed it must be reported to the relevant authority (supervisor, 
foreman, etc.).  The completed task is checked against the task list.  Reporting has to be done 
immediately to enable the manager to form a clear picture of where the team stands against what 
is expected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the transport industry, where operations are run according to a very tight 
schedule, it is especially important for managers at all levels to manage time 

effectively. 
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SECTION 6: FINDINGS AND RECOMMENDATIONS 

 

Specific Outcome 6 

Make findings and recommendations. 

 

Assessment Criteria 

 Findings are explained and used appropriately 
 Conclusions are drawn thereon 
 Findings and recommendations are communicated to both subordinates and management 
 Findings and recommendations are used to devise and recommend new operational 

processes 
 
 
 

6.1 Make Findings And Recommendations 
How variances are identified and interpreted will normally be regulated by specific company 
policies and procedures. 

Upon finding irregularities in any of the reports these variances should be communicated to the 
appropriate authority, using the existing channels of communication.  The manager reporting the 
irregularities should consider all facts, including the activities of the respective individuals 
involved as well as their specific responsibilities in this regard.  This will ensure that credible 
deductions are made from the information.  Beware of making assumptions. 

The person responsible for the investigation of irregularities should make sure of all the facts and 
findings and the implication thereof before considering the appropriate action. 

 

 Communicate findings and recommendations 

It is of absolutely no use if the findings and recommendations resulting from an investigation is 
filed without any action being taken.  It is very important to communicate these findings and 
recommendations to all involved, superiors as well as subordinates.  Once again, the company 
policies and procedures should regulate the communication of information in this regard. 

 

 Implementation 

Abovementioned findings and recommendations should not only be noted.  If it is found that it is a 
recurring incident it might indicate that there is a problem with the standard procedure or 
operational process that needs to be changed.  Findings and recommendations can then be used to 
motivate a change to the process or procedure. 
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Conclusion 
As we have seen, information and the gathering, recording and management thereof is crucial to 
the success of any transport operation. 

Management can identify trends from this information and use it in their strategic planning as well 
as in the day to day running of the operation. 

It therefore stands to reason that to keep abreast of developments the company needs to revise 
and update their policies and procedures pertaining to communication and the management 
thereof on a regular basis. 
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